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What Is Report Generator?
The Report Generator is a software package that can take any information 
from your MATLAB® workspace and export it to a document in the form of a 
report. The reports that you create with the Report Generator can include 
figures, data, variables, and functions from your models or M-files, as well as 
snapshots of system graphics and figures.

Two Report Generator Packages
There are two Report Generator packages: the MATLAB Report Generator and 
the Simulink® Report Generator. If you want to create reports for MATLAB 
M-files, you need the MATLAB Report Generator. If you want to create reports 
for Simulink or Stateflow® models, you need both the MATLAB Report 
Generator and the Simulink Report Generator, which is built atop the 
MATLAB Report Generator. 

This manual documents both the MATLAB Report Generator and the 
Simulink Report Generator. This manual also documents fixed point 
components, which are included with Simulink Fixed Point.

Multiple Report Formats
One of the key features of the Report Generator is that you can create reports 
in multiple documentation formats, such as

• Rich Text Format (RTF)

• Extensible Markup Language (XML)

• Hypertext Markup Language (HTML)

Report Generator Overview 
The Report Generator consists of several parts, which are shown in the 
following diagram.



What Is Report Generator?

1-3

Report Generator Part Description

Report Generator Includes the Report Explorer, the graphical user 
interface (GUI) for Report Generator. Report 
Generator is shown as a dashed box because you 
can use the Report Explorer or the MATLAB 
command line to generate reports and edit setup 
files. 

Setup File Specifies which components will be in the 
report, as well as component attributes and 
component relationships.

Components Controls the report generation process and 
insert information into a report with 
self-contained, modular elements, such as the 
Evaluate MATLAB Expression component or 
the Handle Graphics® Property Table 
component.

Report Generated document that contains the 
information specified by the setup file. Available 
formats include HTML and RTF.

Setup File Report

Components

Report Generator
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Generating a Report
This section describes how to use Report Generator functionality, 
demonstrates how to generate a report, and provides brief descriptions of the 
components used in the setup file. The following topics are included:

• “Opening Report Generator” on page 1-4

• “Generating the Report” on page 1-5

• “Component Descriptions” on page 1-7

Opening Report Generator
With Report Generator, you can generate reports, build setup files, and convert 
DocBook XML files. To access Report Generator functionality, you can use the 
MATLAB command line or the Report Generator graphical user interface, the 
Report Explorer. 

Opening Report Generator from the MATLAB Command Line
To open the Report Generator interface, enter report at the MATLAB 
command line. You can also enter setedit and rptconvert with no arguments 
to open Report Generator. 

Opening Report Generator from the MATLAB Desktop
To use the Report Explorer without going to the MATLAB command line, click 
the MATLAB desktop Start button -> MATLAB -> MATLAB Report 
Generator -> Report Explorer. If you are using Simulink Report Generator, 
click the MATLAB desktop Start button -> Simulink -> Simulink Report 
Generator -> Report Explorer.

Opening Report Generator from Simulink
In a Simulink model, you can open Report Generator directly by selecting the 
Tools menu -> Report Generator. 
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Generating the Report
To generate reports with Report Generator, you can use the Report Explorer or 
the MATLAB command line. To decide which report generation method to use, 
see the table below.

Using the Command Line to Generate a Report
You can generate a report without opening the setup file, using the MATLAB 
command line. Type the following statement at the command line:

report <SetupFileName>

For example, if you type report ch1-tutorial, the report is generated.

To generate multiple reports, type the following statement at the MATLAB 
command line:

report ('<SetupFileName1>','<SetupFileName2>',...)

Report Generator creates the corresponding reports in the order specified by 
the input arguments. 

Note  If you type report without any input argument, the Report Explorer 
interface appears. The Report Explorer lists all the setup files you have on 
your path.

If You... Use

Know the setup file you want to use and you don’t need 
to edit it

Command line

Want to generate a report from an existing setup file 
(or edit the setup file) but are not sure of the name of 
the file or if it is on your path

Report Explorer

Want to create a new report, or edit an existing setup 
file (for example, if you want to customize a standard 
setup file or edit one of your own setup files)

Report Explorer
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Using the Report Explorer to Generate a Report
You can also use the Report Explorer to generate a report. The following 
procedure opens the setup file before generating a report. 

1 In the Options palette, double-click ch1-tutorial.rpt to open the setup file.

The properties panel displays the basic report options:

2 Click the Report button  in the toolbar. The report is generated.

By default, the ch1-tutorial report is generated in HTML. Many other 
generation options are available. For more information, see “Setting Report 
Output Options” on page 2-2.

While the report is generating, the following events occur:

• All options in the Report Explorer become inactive.

• The Outline panel highlights each component as it is executing.

• The Report Explorer shows the report generation status.

After report generation is complete, your Web browser opens to display your 
report:
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If your report is not displayed, make sure that the View report after 
generating check box is selected in the properties panel.

Alternative Methods to Generate Reports
Report Generator gives you several options to initiate report generation. You 
can start report generation by

• Selecting the File menu -> Report

• Selecting the Generate Report button in the properties panel

• Selecting the Report button in the Report Explorer toolbar

• Right-clicking a setup file in the Options palette

Component Descriptions
The components in the setup file determine the information contained in the 
generated report. The ch1-tutorial setup file contains four components:

Paragraph Component
Evaluate MATLAB Expression Component
Figure Snapshot Component
Handle Graphics Property Table Component



1 Getting Started with Report Generator

1-8

The following sections show the information each component in the outline 
inserts into the report:

• “Paragraph Component” on page 1-8

• “Evaluate MATLAB Expression Component” on page 1-8

• “Figure Snapshot Component” on page 1-9

• “Handle Graphics Property Table Component” on page 1-9

Paragraph Component
The first component in the setup file is a Paragraph component. The Paragraph 
component inserts the following paragraph in the report.

When peaks.m runs in the workspace, the following text is
displayed to the Command Window:

Evaluate MATLAB Expression Component
The second component in the setup file is an Evaluate MATLAB Expression 
component. This is represented in the setup file by

Eval String-%Evaluate PEAKS in the base workspace.

This component evaluates the following M-code:

%Evaluate PEAKS in the base workspace.

%Clears other open figures.
close all

%Creates the figure.
peaks

%Set the figure print size to 5x4 inches.
set(gcf, ...

PaperPosition ,[1 1 5 4],...
PaperUnits , inches );

and inserts the command-line output in the report.

z = 3*(1-x).^2.*exp(-(x.^2) - (y+1) ...
- 10*(x/5 - x.^3 - y.^5).*exp(-x.^2-y.^2) ...
- 1/3*exp(-(x+1).^2 - y.^2)
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Figure Snapshot Component
The third component in the setup file is the Handle Graphics Figure Snapshot 
component. The Handle Graphics Figure Snapshot component inserts a 
snapshot of the current figure into the report. Because the Evaluate MATLAB 
Expression component created the Peaks image, it is the current image and is 
inserted into the report.

Handle Graphics Property Table Component
The fourth component in the setup file is the Handle Graphics Property Table 
component. The Handle Graphics Property Table component inserts a table of 
selected Handle Graphics figure property name/property value pairs for the 
Peaks image.

PaperPosition: (1.00, 1.00) 5.00 x 4.00 inches
PaperOrientation: portrait
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Using the Report Explorer
A report consists of information that is specified by the components in its setup 
file. You can think of the setup file as a container for components. To build a 
setup file, you add components. For example, if you want to include a 
paragraph of text in a report, you add a Paragraph component. 

The Report Explorer serves as the primary graphical user interface (GUI) for 
Report Generator. With Report Explorer, you can

• Browse setup files and Report Generator components on the MATLAB path

• Create new setup files

• Open, modify, and delete existing setup files and components

• Generate reports

To start the Report Explorer, select Report Generator from the MATLAB 
Start menu or enter report at the MATLAB command line. The Report 
Explorer GUI features three panels:

Outline panel Displays the structure of the setup file currently open in 
the Report Explorer

Properties panelOptions paletteOutline panel
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You use the Report Explorer to select and organize the components that you 
want in the setup file. The outline of the current setup file is displayed in the 
Outline panel of the Report Explorer. The outline contains all the components 
that will be included in the report. Child components are always shown 
indented under their parent component: 

Note  If you need help with a component, select the component in the Options 
palette or Outline panel and click the Help button in the properties panel.

You can perform the following component operations with the Report Explorer:

• “Creating New Setup Files” on page 1-12

• “Adding Components” on page 1-13 

• “Moving Components” on page 1-14

• “Deleting Components” on page 1-15

• “Activating and Deactivating Components” on page 1-16

• “Cutting, Copying, and Pasting Components” on page 1-17

• “Using Variable Notation in Text Fields” on page 1-18

• “Using the Preferences Dialog Box” on page 1-20

Opening Setup Files
You use the Report Explorer to open existing setup files. To open a setup file, 
follow these steps:

Options palette Displays the available setup files or, when a setup file is 
open, displays the available components 

Properties panel Displays properties for the currently selected object in 
the Report Explorer
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1 To open the Report Explorer, enter report at the MATLAB command line.

2 In the Options palette, select a setup file.

3 In the properties panel, click Open. The report opens.

Note  If you do not have a license for Report Generator for Simulink, you will 
not be able to edit or add Simulink or Stateflow components.

Alternate Methods for Opening Setup Files
You can also open setup files by

• Selecting the File menu -> Open Report

• Double-clicking the setup file in the Options palette

• Typing setedit <setup_filename> at the MATLAB command line

• Typing Ctrl+O on your keyboard

• Selecting the Tools menu -> Report Generator in Simulink

• Right-clicking the setup file in the Options palette -> Open Report

Creating New Setup Files
You use the Report Explorer to create a new setup file. In Report Generator, 
setup files are saved as *.RPT files. To create a new setup file, follow these 
steps:

1 Open the Report Explorer.

2 Click the New button  in the toolbar. 

A new setup file appears in the Outline panel:
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Alternate Methods for Creating New Setup Files
You can also create new setup files by

• Selecting the File menu -> New

• Selecting the Create and edit new setup file button in the properties panel 
for the Report Generator root

• Right-clicking in the Outline panel on the Report Generator node -> New

• Entering setedit <newfilename> at the MATLAB command line

• Typing Ctrl+N on your keyboard

Adding Components
When a setup file is open in the Report Explorer, the Options palette displays 
the available components. To add a component to a setup file, select the 
component that you want to use from the Options palette. 

The general classes of components, such as Formatting, MATLAB, and so on, 
are denoted by a folder icon, . Components for each class are listed below the 
class to which they belong and are denoted by the component icon, . 

To add a component, follow these steps:

1 Create a new setup file in Report Explorer.

2 Select the Chapter/Subsection component in the Options palette and drop it 
in the Outline panel. 

In the Outline panel, the component appears under the Report component:

As the tree view in the Outline panel indicates, components are arranged in 
hierarchical order. Report Generator begins at the top of the tree and proceeds 
until the bottom of the tree. Therefore, you will want to move components 
around in the tree. 
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Moving Components
You can move components in four directions: up, down, left, and right. Four 
buttons located in the toolbar let you move components around in the Outline 
panel.

Note  You must be careful when you move components, especially when there 
are parent-child relationships involved. Some components cannot have 
children, and some components should not be children of other components.

Alternate Methods for Adding Components
You can also add components by

• Clicking the Add component to current report button in the component’s 
properties panel

• Right-clicking the component in the Options palette -> Add component to 
current report

• Dragging the component from the Options palette and dropping it on the 
Outline panel

• Double-clicking the component in the Options palette

Button Purpose Effect

Move up The selected component executes one step earlier 
in report generation.

Move down The selected component executes one step later in 
report generation.

Move left The selected component moves up one level in the 
component hierarchy.

Move right The selected component moves down one level in 
the component hierarchy to become a child of the 
component above.



Using the Report Explorer

1-15

Deleting Components
To delete a component, follow these steps:

1 In the Outline panel, select the component you want to delete. 

2 Click the Delete button  in the toolbar.

The component disappears:

Alternate Methods for Deleting Components
You can also delete a component by

• Selecting the Edit menu -> Delete

• Pressing the Delete button on your keyboard

• Right-clicking in the Outline panel -> Delete

Note  If you delete a component in your setup file that has children, all its 
children are also deleted.

Note  You cannot delete the Report Generator root, which is always at the top 
of the tree structure in the Outline panel.
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Activating and Deactivating Components
You can activate and deactivate individual components in a setup file. When 
active, the component and all its children are included in the generated report. 
When inactive, the component and all its children are not included in the 
report.

You can activate and deactivate components for

• Evaluating a component’s effect on a report

• Testing components to find an report generation error

• Generating multiple versions of a report without creating new setup files

The Outline panel represents active and inactive components with different 
icons:

To activate a component, follow these steps:

1 Select the component to activate in the Outline panel.

2 Click the Activate/Deactivate Component button  in the toolbar. 

The component becomes inactive, as the following figure shows:

Active component

Inactive component
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Alternate Methods for Activating and Deactivating Components
You can also activate or deactivate a component by

• Selecting the Edit menu -> Activate/Deactivate Component

• Right-clicking the component in the Outline panel -> Activate/Deactivate 
Component

Note  If you deactivate a component in your setup file that has children, all 
its children are deactivated as well.

Cutting, Copying, and Pasting Components
The Report Explorer interface provides the ability to cut, copy, and paste 
components in the Outline panel. 

To copy a component, follow these steps:

1 Select the component to copy in the Outline panel.

2 Click the Copy button  in the toolbar.

To cut a component, follow these steps:

1 Select the component to cut in the Outline panel.

2 Click the Cut button  in the toolbar.

To paste a component, follow these steps:

1 Cut or copy a component that you want to paste.

2 Select the area in the outline in which you want to paste the component.

3 Click the Paste button  in the toolbar.

Alternate Methods for Cutting, Copying, and Pasting Components
You can also cut, copy, or paste a component by
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• Selecting the Edit menu -> Cut/Copy/Paste

• Typing Ctrl+C to copy, Ctrl+X to cut, and Ctrl+P to paste

• Right-clicking the component in the Outline panel -> Cut/Copy/Paste

Using Variable Notation in Text Fields
In Report Generator, you can use variable notation to display variables in 
generated reports. To use a variable in a text field, use %<varname> syntax. For 
example, to display the variable myvar, you would express it as %<myvar>.

If a variable represents a large amount of text, Report Generator collapses the 
text automatically to conserve space in a generated report. To make sure that 
a variable’s output is not collapsed, use double angle brackets in the variable 
notation, such as %<<myvar>>.

Sending Report Generator Objects to the MATLAB 
Workspace
The Report Explorer provides a tool that creates a handle in the MATLAB 
workspace to the currently selected object in the Report Explorer. Once you 
have an object handle, you can manipulate the object at the MATLAB 
command line.

Once you create or open a setup file, you can send objects to the workspace. 

1 Create a new setup file by selecting File menu -> New.

A new setup file appears in the Outline panel.

2 Send the object to the MATLAB workspace.

a Select the new setup file in the Outline panel.

b Right-click the setup file, and in the context menu that appears, select 
Send to Workspace.

The object handle is sent to the MATLAB workspace in the ans variable.

3 Assign the object handle to another variable. This step is necessary to avoid 
overwriting the handle when you send another object to the workspace. For 
example, type rgobj = ans.
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After you select Send to Workspace, the setup file object handle appears at the 
MATLAB command line.

ans =
 
[RptgenML.CReport]
             SectionType: 'auto'
           DirectoryType: 'setfile'
           DirectoryName: ''
            FilenameType: 'setfile'
            FilenameName: 'index'
     isIncrementFilename: 0
                  Format: 'html'
              Stylesheet: 'default-html'
                  isView: 1
    isAutoSaveOnGenerate: 0
      isRegenerateImages: 1
             Description: 'A report'
                Language: 'auto'
         PostGenerateFcn: ''
             RptFileName: ''

You can assign the object handle to another variable.

>>rgobj = ans

rgobj =
 
[RptgenML.CReport]
             SectionType: 'auto'
           DirectoryType: 'setfile'
           DirectoryName: ''
            FilenameType: 'setfile'
            FilenameName: 'index'
     isIncrementFilename: 0
                  Format: 'html'
              Stylesheet: 'default-html'
                  isView: 1
    isAutoSaveOnGenerate: 0
      isRegenerateImages: 1
             Description: 'A report'
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                Language: 'auto'
         PostGenerateFcn: ''
             RptFileName: ''

You can also modify the object properties from the command line.

>>rgobj.Format = 'rtf97'

rgobj =
 
[RptgenML.CReport]
             SectionType: 'auto'
           DirectoryType: 'setfile'
           DirectoryName: ''
            FilenameType: 'setfile'
            FilenameName: 'index'
     isIncrementFilename: 0
                  Format: 'rtf97'
              Stylesheet: 'default-fo'
                  isView: 1
    isAutoSaveOnGenerate: 0
      isRegenerateImages: 1
             Description: 'A report'
                Language: 'auto'
         PostGenerateFcn: ''
             RptFileName: ''

Using the Preferences Dialog Box
To change output format defaults, use the Report Generator Preferences 
dialog box. You can change default image file formats, report file extensions, 
and the MATLAB command used to display the generated report. 

To open the dialog box, select the File menu -> Preferences.
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To modify the default file extension used in generated reports, follow these 
steps:

1 Select the desired format in the Format ID text box.

2 Edit the Extension field to your desired file extension. For example, you 
might prefer the .htm extension to .html.

3 Click Apply.

To change the default file format for Simulink, Stateflow, or Handle Graphics 
images, follow these steps:

1 Select the desired format in the Format ID text box.

2 Select the desired file format in the Simulink images, Stateflow images, or 
HG images text boxes.

3 Click Apply.

Output file format
Output file format extension
Simulink image file format
Stateflow image file format
Handle Graphics format
Image visibility
View report command
Reset button
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To make the format available to the Format text box in the Preferences dialog 
box, clear the Visible in Report Explorer check box.

To change the MATLAB command used to view the report, follow these steps:

1 Select the desired format in the Format ID text box.

2 Select the command to use in the View command text box.

- edit('%<FileName>'); — Opens the report in a text editor

- web(rptgen.file2urn('%<FileName>'),'-browser'); — Opens the 
report in the MATLAB Web browser

- docview('%<FileName>','-UpdateFields'); — Opens the report in an 
RTF editor

- ! "%<FileName>" & 

3 Click Apply.

MATLAB replaces %<FileName> with the full file path and name of the 
generated report.

Note  Make sure that the editor or viewer specified in the View Command 
text box supports the applicable output file format. 

To restore the default settings for an output format, select the format in the 
Format ID text box and click Reset to Defaults.
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Where to Go from Here
This documentation contains additional information, including tutorials and 
reference material about Report Generator. For more information, see the 
following sections:

Chapter 2, “Generating 
Reports”

Discusses output and generation options for 
Report Generator

Chapter 3, “Component 
Tutorials”

Provides examples of using various 
components

Chapter 4, “Component 
Reference”

Describes the attributes and the functions of 
the components
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2

Generating Reports

Setting Report Output Options (p. 2-2) Describes report generation options

Converting XML Documents (p. 2-7) Demonstrates how to convert XML source files 
with the Report Explorer

Creating Log Files (p. 2-9) Shows how to create log files for report 
generation

Generating M-Code from Setup Files (p. 2-11) Describes how to generate M-code versions of 
setup files

Working with Legacy Setup Files (p. 2-13) Learn how to work with setup files created in a 
previous version of Report Generator
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Setting Report Output Options
Report Generator lets you control most aspects of report output. For more 
information, see the following sections:

• “Setting the Report File Directory” on page 2-2

• “Setting the Report Filename” on page 2-3

• “Setting the Report Format” on page 2-3

• “Viewing and Printing Your Report” on page 2-6

• “Autosaving the Setup File” on page 2-6

• “Regenerating Images” on page 2-6

• “Including a Report Description” on page 2-6

Setting the Report File Directory
Choose the appropriate directory for the report file according to the table below. 
Make sure you have write privileges for that directory.

You can use the %<VariableName> notation to specify a directory in the Custom 
text box. See “%<VariableName> Notation” in the reference page for the Text 
component. 

Directory Option

The same directory as the 
setup file

Same as setup file

The current working 
directory

Present working directory

Temporary directory Temporary directory

Another directory Custom. Specify a directory in the Custom 
text box (you can use the Browse button (...) 
to select from a list of directories).
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Setting the Report Filename
Choose the appropriate filename for the report file according to the table below.

Images are placed in a directory with the same name as the report file. For 
example, testreport.html images are placed in a directory named 
testreport_files.

You can use the %<VariableName> notation to specify a filename in the Custom 
text box. See “%<VariableName> Notation” in the reference page for the Text 
component.

Setting the Report Format
You can choose the report output format in the File Format text box. You 
should choose the output format according to how you want to view the report. 
For example, if you want to use Microsoft Word, you should choose RTF.

Each output format has a default stylesheet.Specify the stylesheet in the text 
box next to the File Format text box. 

Filename Option

Your report is to have the same 
filename as the setup file.

Same as setup file (default)

Your report is to have a filename 
that is different from the setup file 
name.

Custom. Enter the name of the 
report in the text box.
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The table below shows which output format to use with different viewers or 
software as well as which stylesheets are available for use with each output 
format.

Viewer Format Purpose Stylesheet Options

Web browser Web (HTML) 
(default)

Used for publishing 
on the World Wide 
Web

Web (see “Web Stylesheets” 
on page 2-5)

XML DocBook (no 
transform)

Produces an XML 
document

Text Plain Text Produces a simple 
text file

Word processor Rich Text Format 
(RTF)

Compatible with 
most 
word-processing 
packages, including 
Microsoft Word

Print (see “RTF 
Stylesheets” on page 2-5)

Adobe Acrobat 
Reader

Portable Document 
Format (PDF)

Produces a PDF 
that can be viewed 
with Acrobat 
Reader
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Web Stylesheets

RTF Stylesheets

Web Stylesheet Description

Default HTML 
stylesheet

HTML on a single page

Simulink book HTML 
stylesheet

HTML

Truth Table HTML 
stylesheet

HTML

RTF Stylesheet Description

Standard Print Displays title page, table of contents, list of 
titles

Unnumbered Chapters & 
Sections

Chapters and sections are not numbered.

Numbered Chapters & 
Sections

Chapters and sections are both numbered.

Compact Print Minimizes white space to reduce page count

Compact Simple Print Minimizes page count, suppresses title, table of 
contents, list of titles

Large Type Print Uses 12 point font (slightly larger than 
Standard Print)

Simple Print Suppresses title page, table of contents, list of 
titles

Very Large Type Print Uses 24 point font and landscape paper 
orientation
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Note  Some Web and print stylesheets include an automatically generated 
list of titles. The list of titles includes a list of table titles and a list of figures 
with titles.

Viewing and Printing Your Report
To view your report after generation, you have the following options:

• To view the report automatically, use the View report after generating 
option in the Generation Options section in the properties panel. When 
report generation is complete, the viewer associated with the report output 
format you chose is launched, displaying the report.

• To view the report from the MATLAB command line, use the rptviewfile 
command, such as rptviewfile ch1-tutorial.

• To view the report manually, browse to the location specified in the Report 
File Location section in the properties panel and open the file.

If you want to print your report, select the print option from the viewer.

Autosaving the Setup File
To automatically save the setup file before you generate a report, select Save 
setup file on generation, which is located in the Generation Options section 
of the properties panel.

Regenerating Images
By default, the Regenerate Simulink and Stateflow Images option in the 
Generation Options section of the properties panel is not selected. Previously 
generated images are not regenerated each time you generate a report, which 
results in faster report generation. If you have made any changes that could 
affect the image, you should select this option.

Including a Report Description
Use the Report Description field in the properties panel to make notes and 
comments on your setup file. This text appears in the properties panel when 
you select a setup file in the Options palette. 
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Converting XML Documents
If you want to generate the same report in a different output file format 
without regenerating the report, you can use the rptconvert command. The 
rptconvert command transforms a DocBook XML source file generated in 
Report Generator into a formatted document, such as HTML, RTF, or PDF.

Note  Report Generator can only convert XML source files created by the 
latest version of Report Generator. 

Converting XML Documents with Report Explorer
To open the Convert properties panel, follow these steps:

1 In the Report Explorer, select Tools menu -> Convert source file.

The Convert properties panel appears:

2 Select your XML source file:

a In the Convert properties panel, click the button next to the Source file 
text box to display the Select a Report Generator source file dialog box.
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b In the dialog box, browse to your XML source file, select it, and click OK.

3 Select your output format and stylesheet:

a In the File format text box, select an output format. 

b In the Stylesheet text box, select a stylesheet. The stylesheet choice 
depends on the selected output format.

For more information about available formats and stylesheets, see “Setting 
the Report Format” on page 2-3.

4 To begin the conversion, click the Convert file button.

Converting XML Documents at the Command Line
To convert files outside the Report Explorer interface, you can use rptconvert 
from the command line with varying levels of definition:

• <ReportName>=rptconvert('<DocBookFileName>'), where <ReportName> is 
the name of your report, and DocBookFileName is the name of the DocBook 
file (with or without the .xml extension). The default format (HTML) and 
stylesheet (Single-Page Web) are used.

• <ReportName>=rptconvert('<DocBookFileName>',format); where the 
valid format arguments are

- HTML

- RTF95

- RTF97

- FOT (for XML)

The format name should be entered in single quotation marks, for example, 
'HTML'. The default stylesheet for the selected option is used.

• <ReportName>=rptconvert('<DocBookFileName>',format,stylesheet); 

For a discussion of valid stylesheet options for each output format, see 
“Setting the Report Format” on page 2-3. Type 
rptconvert #STYLESHEETLIST for a list of valid stylesheet arguments. 
Enclose the stylesheet name in single quotation marks.
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Creating Log Files
In Report Generator, a log file documents a setup file, including report 
generation settings and components. A log file can be used for many purposes, 
including

• As a debugging tool

• As a reference to a setup file

• To share information about a setup file through e-mail

A log file includes the following:

• Setup file outline

• Components and their attributes

• Generation status messages currently displayed in the Generation Status 
tab

• All MATLAB licenses

To generate a log file, select Log File from the File menu. An HTML version of 
the log file is saved in the same directory as the setup file and is named 
<setupfilename>_log.html. The log contains

• Setup file table

• Setup file table of contents

• Table of details for each component in the setup file

• Product version table

The following figure shows the MATLAB Web browser displaying part of the 
log file for the ch1-tutorial setup file:
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Setup file title

Setup file table of contents

Component details
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Generating M-Code from Setup Files
Using Report Generator, you can generate M-code versions of setup files in the 
form of an M-file (*.m). An M-file of a setup file is useful for a variety of 
purposes, including generating reports and modifying setup files 
programmatically.

To generate an M-file from Report Generator, a setup file must already be 
loaded. Select File -> Generate M-File. After generation, the M-file opens in 
the MATLAB Editor. The M-file is saved in the same location as the setup file.

As an example, the ch1-tutorial setup file generates the following M-code:

function [rptgenml_creport1] = buildch1_tutorial
%BUILDCH1_TUTORIAL 
%% Create RptgenML.CReport
rptgenml_creport1 = 
RptgenML.CReport(...'DirectoryType','pwd',...'Format','html',...                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                           
'Stylesheet','default-html',...'Description',['A simple version 
of mfile-report.rpt',
char(10),'',char(10),'This setup file has five components:',
char(10),'1) Report - specifies the output file location and file
format',char(10),'2) Paragraph - inserts a single paragraph into 
the report',char(10),' 3) Eval - evaluates a MATLAB command and 
inserts command window output',char(10),' 4) Figure Snapshot - 
inserts a picture of the figure created during eval',char(10),' 
5) Figure Prop Table - inserts a property-value table reporting 
on the figure',char(10),'',char(10),'This report is discussed in 
detail in the first chapter of the Report Generator 
documentation.'],...'RptFileName',
'C:\WINNT\profiles\user\Desktop\ch1-tutorial.rpt');
%% Create rptgen.cfr_paragraph
rptgen_cfr_paragraph1 = 
rptgen.cfr_paragraph('ParaTitle','','ParaText','When peaks.m 
runs in the workspace, the following text is displayed to the 
command window:');
setParent(rptgen_cfr_paragraph1,rptgenml_creport1);                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    
%% Create rptgen.cml_eval
rptgen_cml_eval1 = rptgen.cml_eval(...'EvalString',['%Evaluate 
PEAKS in the base workspace',char(10),'',char(10),'%This clears 
other open figures.',char(10),'close all',char(10),'',char(10),
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'%This creates the figure.',char(10),'peaks',char(10),'',
char(10),
'%This sets the figure print size to 5x4 inches',char(10),
'set(gcf,...',char(10),''PaperPosition'',[1 1 5 4],
...',char(10),'''PaperUnits'',''inches'');'],... 
'isCatch',false,...'CatchString','disp([''Error during eval: '', 
lasterr])',... 'isInsertString',false);
setParent(rptgen_cml_eval1,rptgenml_creport1);
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Working with Legacy Setup Files
Legacy setup files created in a previous version of Report Generator can still be 
used in the latest version. You can load legacy setup files in the Report 
Explorer, or you can use the previous versions of the Report Generator 
interfaces to work with legacy setup files. 

Enabling the Legacy Report Generator Interfaces
You enable the previous versions of the Report Generator interfaces at the 
MATLAB command line. To enable the legacy interfaces, enter

RptgenML.v1mode(true)

at the MATLAB command line. MATLAB responds with 

ans =

     1

A logical 1 indicates that Version 1 mode is on. To turn Version 1 mode off, 
enter

RptgenML.v1mode(false)

at the MATLAB command line. MATLAB responds with

ans =

     0

A logical 0 indicates that Version 1 mode is off.
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Using the Legacy Report Generator Interfaces
When Version 1 mode is enabled, you can use the previous versions of the 
Report Generator interfaces. When Version 1 mode is enabled, the MATLAB 
functions related to Report Generator also load the old interfaces.

setedit
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Keep the following points in mind when using the previous versions of Report 
Generator interfaces:

• You cannot use a setup file created in the latest version of Report Generator 
with the old interfaces. If you save a legacy setup file in the latest version of 
Report Generator, you will not be able to work with the same setup file in the 
old interface.

• You cannot use the old interfaces with the latest version. While the Setup 
File Editor can coexist with the Report Explorer, it is not recommended.

rptlist

rptconvert
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Component Tutorials

Working with Looping Components (p. 3-2) Describes the usage of looping components

Working with Property Table Components (p. 3-11) Describes the usage of property table 
components

Working with Summary Table Components (p. 3-23) Describes the usage of summary table 
components
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Working with Looping Components
A looping component runs its child components several times. Report 
Generator offers numerous looping components, including logical loops, 
Simulink loops, Stateflow loops, and Handle Graphics loops. Most loops share 
common characteristics. For that reason, this tutorial focuses on the Figure 
Loop component as representative of most looping components.

The Figure Loop runs its child components several times, each time applying 
its child components to Handle Graphics figures. The figloop-tutorial setup 
file generates a report that documents multiple Handle Graphics figures.

The figloop-tutorial setup file contains a Figure Loop component as well as 
other components, including

• Title Page

• Chapter/Subsection

• Evaluate MATLAB Expression

• Import File

• Summary Table

• Handle Graphics Name

• Handle Graphics Linking Anchor

• Figure Snapshot

• Handle Graphics Property Table

Note  For more information about property table components, see “Working 
with Property Table Components” on page 3-11.

Opening the Setup File
To use the figure loop tutorial and edit the setup file, type the following at the 
command line:

setedit figloop-tutorial

The setup file for the figure loop tutorial appears in the Report Explorer.
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Creating Handle Graphics Figures
There are three important Handle Graphics concepts you need to be familiar 
with before proceeding with the rest of this tutorial:

• Invisible figures

• HandleVisibility parameter

• Tags

For more information on Handle Graphics concepts, see the MATLAB Handle 
Graphics documentation.

Invisible Figures
When you type figloopfigures, Figures 1, 3, and 5 appear, but Figures 2 and 
4 do not. Figures 2 and 4 are invisible (visible='off'), so you can only see 
three figures. An invisible figure does not appear on screen; it exists, but it is 
hidden.

HandleVisibility Parameter
Figures 3 and 4 have HandleVisibility='off'. HandleVisibility is a 
parameter of a Handle Graphics figure, and it determines whether the handles 
in your figure are visible. The figure can be found because it is a child of root. 
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For more information on HandleVisibility, see the Using MATLAB Graphics 
documentation.

To list all figures in your workspace that have HandleVisibility='on', type 
get(0,'children')at the command line. The results show that Figures 5, 1, 
and 2 have HandleVisibility='on'.

ans =
     5
     1
     2

Note that most figures have HandleVisibility='on'. To turn 
HandleVisibility off, you have to specify HandleVisibility='off' with the 
following:

set(handle,'HandleVisibility','off')

Tags
A Handle Graphics figure can have a tag. A tag is a Handle Graphics figure 
parameter. A tag does not appear in a figure; it is an identifier that you specify.

If you want to see what tag, if any, a figure has, type get(<handle>, 'tag'). 
The handle of a figure is the figure number; enter the figure number for 
<handle>. For example, to see whether Figure 1 has a tag, type get(1, 'tag'), 
and MATLAB outputs the following response:

ans =
     membrane

This means that Figure 1 has a tag called membrane. Every figure in this 
tutorial has a tag. However, by default, figures have empty tags.
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Figure Summary
The following table shows visibility (figure is visible if visible='on' and 
invisible if visible='off'), HandleVisibility, and tags for the figures in the 
tutorial.

To create the Handle Graphics figures, type figloopfigures at the MATLAB 
command line. Figures 1, 3, and 5 appear on the screen, but Figures 2 and 4 do 
not because they are invisible. 

The following figure shows Figures 1, 3, and 5.

Figure Name Visible HandleVisibility Tag

1 Membrane Data on on membrane

2 Invisible 
Membrane Data

off on membrane

3 An Application on off app

4 An Invisible 
Application

off off app

5 Peaks Data on on peaks
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Membrane Data
An Application

Peaks Data
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Figures 2 and 4, which do not appear on the screen, are shown below.

Before you continue with the rest of the tutorial, it is important that you 
understand some important Handle Graphics concepts, such as invisible 
figures, HandleVisibility parameters, and tags. 

Editing the Figure Loop Component
Select the Figure Loop component in the Outline panel. The properties panel 
for the Figure Loop component appears.

Invisible Membrane Data

An Invisible Application
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Looping on the Current Figure
To include a snapshot of the current figure in the report, you must first select 
a figure. Select the Figure 5 window (“Peaks Data”) to make Figure 5 current.

To include only the current figure in the report, select Current figure only 
from the Include figures list. Click the Report button  to generate a report.

Note  When you choose Current figure only, “current figure” refers to the 
figure that is current when the report is generated. This might not be the 
same figure you selected as the current figure in the Report Explorer before 
report generation. For example, if the report generation process creates 
figures in your report, then the last figure created with HandleVisibility = 
'on' is the current figure.
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Looping on All Visible Figures
To include snapshots of all visible figures in your report, select Visible 
figures in the Include figures list. This option inserts a snapshot and 
property table for all figures that are currently open and visible.

With HandleVisibility='on'. The Data figures only (Exclude applications) 
option is selected by default and excludes figures with HandleVisibility = 
'off' from the loop. Click the Report button  to generate a report. Notice 
that the report contains the figures “Membrane Data” and “Peaks Data.”

With HandleVisibility='on' or 'off'. Now clear the Data figures only option. 
Figures with HandleVisibility = 'on'(“Membrane Data” and “Peaks Data”) 
and HandleVisibility = 'off' (“An Application”) are now included in the 
loop. 

Click the Report button  to generate a report. Notice that the report now 
contains “Membrane Data,” “An Application,” and “Peaks Data.”

Looping on Figures with Certain Tags
To include figures with certain tags, select the All figures with tags option. 
When you select a tag, all figures with that tag are included, regardless of 
whether the figure is visible or whether HandleVisibility is 'on' or 'off'.

For a brief discussion of Handle Graphics tags, see “Tags” on page 3-4.

Modifying Section Options
The Figure Loop component provides controls for section options. In a Report 
Generator loop, a section refers to a space in the generated report in which 
information is displayed, including text, images, tables, and so on. Using the 
options available in the Section Options pane, you can alter how the sections 
generated by the loop are displayed in the report.

Create a section for each object in loop. To enable the loop to create a section for 
each object in the loop, select this option. This option is useful when a loop does 
not contain a child Chapter/Subsection component that organizes the loop 
results. When selected, the loop automatically creates an individual section for 
each object found in the loop and uses the object title as the section title. 

In the figloop-tutorial setup file, this option is not needed because the 
Figure Loop component has a child Chapter/Subsection component that 
already organizes the loop results.
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Display the object type in the section title. To include the object type in the section 
title, select this option. When selected, the section titles in the generated report 
are prefaced by object types. For example, in a report generated from the 
figloop-tutorial setup file without this option selected, the list of figures 
produced by the loop would look like

Membrane Data
Invisible Membrane Data
An Application
An Invisible Application

With the option enabled, the list of figures would look like

Figure - Membrane Data
Figure - Invisible Membrane Data
Figure - An Application
Figure - An Invisible Application

Create link anchor for each object in loop. To create a hyperlink to the object in the 
generated report, select this option. 
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Working with Property Table Components
Property table components display property name/property value pairs in a 
table. Report Generator offers numerous property table components, including 
the MATLAB Property Table component, the Simulink Property Table 
component, the Stateflow Property Table component, and so on. 

Report Generator property table components share common characteristics. 
For that reason, this tutorial uses the Handle Graphics Property Table 
component as a representative of all property table components. 

Opening the Setup File
To use the figure loop tutorial and edit the setup file, type the following at the 
command line:

setedit figloop-tutorial

The figure loop tutorial setup file appears in the Report Explorer.



3 Component Tutorials

3-12

Examining the Property Table Output 
The Handle Graphics Property Table component displays property 
name/property value pairs in a table for Handle Graphics figures, axes, or 
plots.

Property Table
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Property pages for all property table components are similar in form. The 
following figure shows the properties panel for the Handle Graphics Figure 
Property Table component:

The Edit button opens a dialog box in which you can modify most table 
settings. 

Displaying Property Name/Property Value Pairs 
The following sections discuss property name/property value pair display 
options.

Split Property/Value Cells
In the Handle Graphics Property Table component’s properties panel, click the 
Edit button, and a dialog box appears. To have the property name and property 
value appear together in one cell, deselect the Split property/value cells check 
box. This is nonsplit mode. In nonsplit mode, you can have more than one 
property name/property value pair per cell and you can also have additional 
text.

Edit button
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To have the property name and property value appear in adjacent horizontal 
cells in the table, select the Split property/value cells check box. In this case, 
the table is in split mode and there can be only one property name/property 
value pair in a cell. 
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If you have more than one property in a cell, then only the first pair is displayed 
in the report; all subsequent pairs are ignored.

Display Options
Each table cell in the report can display a property name/property value pair 
in several ways. To select how a property name/property value pair is displayed 
in a table cell in the report, select that field in the table and choose Value in the 
Display As text box. 

Note that in the selected table row, only the value is displayed. 

Alignment Options
The text in each cell can appear in the report in one of four ways, using the 
corresponding justification button:
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Note that the selected table row is double-justified.

You can also right-click a table row and change justification options in the 
context menu that appears.

Putting Text into a Table Cell
You can type text in a table cell in the table dialog box. For the text to be visible, 
the table must be in nonsplit mode. To enter text in a cell, double-click the table 
cell. A gray box appears with the label for the cell property. 
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If you type text outside the angle brackets, the text appears as text in the 
report. If you type text inside the table brackets, the text must be a valid 
property name. If you type an invalid property name, then that property name 
appears in the report without a property value.
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Editing the Table Title
The table has a title that you can edit. The title of a table is the same as the 
value of the %<Name> property. The title of the table can contain properties and 
text. The title is always in nonsplit mode. To modify the title, modify the 
%<Name> entry.

If the table has a title, it appears in the list of tables in the generated report. 
Some stylesheets offer a list of tables. For a list of stylesheets that offer this 
option, see Chapter 2, “Setting the Report Format.”

To enter a property, follow the steps described in “Adding, Replacing, and 
Deleting Properties in a Table” on page 3-18.

Adding, Replacing, and Deleting Properties in a 
Table
To add, replace, or delete properties in a table, you must launch the table editor 
dialog box. To launch the table editor, click the Edit button in the Property 
Table component’s properties panel. The following figure shows the table editor 
for a Handle Graphics Property Table component:

Adding a Property
To add a Handle Graphics property to a table cell in the table editor, follow 
these steps:
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1 Launch the table editor.

2 Add a new, blank table row to the current table. 

a Select a table row directly below the location where you want to add a 
new property.

b Click the Add Row Above Current Cell button . A blank table row 
appears. 

3 Add the property to the new table row.

a Select the new table row.

b In the Properties Type menu, select the property type that you want. In 
the Properties menu, select the property that you want to add.

c Click the Add button or double-click the property name. The property 
appears in the table row. 

If you know the name of the property, you can also type the property name in 
the cell. For more information, see “Putting Text into a Table Cell” on 
page 3-16. For information about adding new table rows, see “Adding, 
Replacing, and Deleting Properties in a Table” on page 3-18.

Properties Type
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Replacing or Deleting Properties
In nonsplit mode, you can replace a property in a table cell in the Setup File 
Editor by following the instructions in “Putting Text into a Table Cell” on 
page 3-16. You can delete a property by backspacing over it.

To replace a Handle Graphics property in a cell when the table is in split mode, 
follow the instructions in “Adding a Property” on page 3-18. You cannot use 
these steps to delete a Handle Graphics property in a cell when the table is in 
nonsplit mode, because such cells can have more than one property 
name/property value pair.

Displaying or Hiding Table and Cell Borders
You can toggle the table and cell borders on and off in the Property Table by 
using the context menu.

To toggle a cell border on and off, place your cursor in the desired cell and 
right-click to invoke the context menu. Choose Cell borders and then select 
Top, Bottom, Right, or Left to toggle the desired border on or off.

Adding and Deleting Columns and Rows
To add or delete a column or row, select a cell, and then click one of the buttons 
described in the following table.

You cannot delete a row or column when it is the only row or column in the 
table.

Resizing Columns
To resize the column width, click and drag the vertical border between cells.

Button Action

Add column (added to the left of the selected column)

Delete selected column

Add row (added above the selected row)

Delete selected row
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Zooming and Scrolling
While you are editing the table in the setup file, you can zoom in and out of the 
table with the zoom buttons, located to the left of the horizontal scroll bar.

You can scroll vertically and horizontally with the corresponding scroll bars 
around the table.

Selecting a Table
You can select a preset table to display property name/property value pairs, or 
you can create a custom table.

Preset Tables
A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table drop box in the upper left corner of the 
properties panel. To apply a preset table, select the table and click the Apply 
button. 

Custom Tables
To create a custom table, you can select a preset table and modify that table to 
fit your needs. You might want to start with the Blank 4x4 preset table. You 
can add and delete rows and you can add properties.

Note  You cannot save a custom table as a preset table. If you create a table 
and then select a preset table, all your changes are lost.

Button Action

Zoom in

Zoom out
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Selecting Object Types
Property and summary table components offer multiple object types on which 
to report. For example, the Handle Graphics Property table lets you report on 
a figure, an axes object, or a Handle Graphics object. 

To select a different object type, use the Object type list in the component’s 
properties panel.

The Handle Graphics Summary Table component offers the same object type 
options. Deciding which object type to select depends on the object that you 
want to include in the generated report. The Simulink Property Table and 
Simulink Summary Table component include block, model, signal, and system 
object types.
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Working with Summary Table Components
Summary table components insert tables containing the details on the selected 
object into generated reports. The generated tables contain one object per table 
row, and each object property is a table column. Report Generator offers 
numerous summary table components, including the Handle Graphics 
Summary Table component, Simulink Summary Table component, and the 
Stateflow Summary Table component.

Report Generator summary table components share common characteristics. 
For that reason, this tutorial uses the Handle Graphics Summary Table 
component as a representative of all summary table components.

A summary table can contain many properties. For example, the 
simulink-summary setup file contains multiple Simulink Summary Table 
components that report on Simulink blocks in the f14 model and their 
properties. 

Like the other sections in the chapter, this tutorial uses the figloop-tutorial 
setup file.
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Examining the Report Output and the Setup File
In the generated report, summary table components generate tables that 
contain the specified properties for the selected object. The following figure 
shows the summary table produced by the figloop-tutorial setup file.

In the figloop-tutorial setup file, the Handle Graphics Summary Table 
component is the child of a Chapter/Subsection component.

Summary Table component
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Selecting an Object Type
You can select different Handle Graphics object types for the summary table, 
including blocks, signals, systems, and models, with the Object type list in the 
component’s properties panel. The figloop-tutorial setup file contains one 
Handle Graphics Summary Table component, and it reports on figure objects.

The properties available to add to the table depend on the selection in the 
Object type list. 

Adding and Removing Properties
In the Property Columns pane, you select the object properties to be displayed 
in the generated report. Depending on the object type, you can select any object 
property to add to the summary table.

To add a property to the summary table, select the property category from the 
box to the right of the Property columns field. As you select different property 
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categories, notice that the field below the box changes to display the category’s 
properties. 

To add a property to the table, select the property in the properties list and 
click the Add button . The property should appear in the Property columns 
field. To remove a property from the table, select the property in the Property 
columns field and press Delete. The property name should disappear from the 
Property columns field.

Note  After making a change in the Report Explorer interface, you must click 
the Apply button for the changes to take effect.

You can also specify your own properties by entering the name manually in the 
Property columns field. You must use proper Report Generator variable 
notation. For more information, see “Using Variable Notation in Text Fields” 
on page 1-18.

Setting Relative Column Widths
Using the Relative column widths field, you apply a relative column width to 
the summary table columns in the generated report. Column width is entered 
as a relative ratio. If omitted, column widths are determined automatically.

Setting Object Row Options
In the Object Rows pane, you configure options for the table rows, including 
anchor, filtering, and sorting options. Selecting the Insert anchor for each 
row option places an anchor in each table row in the generated report. 

Property category box

Properties list
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Using the Include figures list, you specify what objects are reported on in the 
summary table. For example, in the figloop-tutorial setup file, the 
summary table components report on figure objects. If you select All Figures 
with tags, Report Generator reports on all figure objects that match the tags 
specified. If you select Current figure only, Report Generator only reports on 
the selected figure. If you select Visible figures, Report Generator only 
reports on visible figure objects. 

Insert anchor for each row
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Component Reference

Components — Categorical List (p. 4-2) Report Generator components by category

Components — Alphabetical List (p. 4-24) Report Generator components by name
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Components — Categorical List 4

Report Generator offers a variety of components, including formatting, 
MATLAB, and logic components. Depending on the other MathWorks 
applications you have installed, you can also use Simulink, Stateflow, and 
Simulink Fixed Point Blockset components in your setup files. 

Report Generator components fall into eight categories. For more information, 
see the following sections:

• “Formatting Components” on page 4-2

• “Report Generator Components” on page 4-5

• “Logic and Flow Control Components” on page 4-6

• “Handle Graphics Components” on page 4-8

• “MATLAB Components” on page 4-11

• “Requirements Management Interface Component” on page 4-12

• “Simulink Components” on page 4-12

• “Simulink Blocks Components” on page 4-17

• “Stateflow Components” on page 4-18

• “Simulink Fixed Point Blockset Components” on page 4-21

Formatting Components
You can use Formatting components to insert documentation elements in your 
report. Formatting components must have the following parent/child 
relationships.
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The following table describes the Formatting components.

Component Description

Chapter/Subsection Groups portions of the report into sections. The 
following rules apply to the Chapter/Subsection 
component:

• Children of the Chapter/Subsection component 
are placed inside the section created by this 
component.

• The Chapter/Subsection component can nest 
inside another Chapter/Subsection component.

Image Inserts an image into the report. The Image 
component can have the Chapter/Subsection or 
Paragraph component as its parent.

Title Page Chapter/Subsection

Chapter/Subsection

List 
Paragraph

Text Link Table
Image
List

Report
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Link Inserts a link or anchor into the report. The Link 
component should have the Paragraph component 
as its parent. If you select Anchor in the Link 
Type list, then the Link component can also have 
the Chapter/Subsection component as its parent.

List Inserts a bulleted or numbered list into the report. 
The List component must have the 
Chapter/Subsection or Paragraph component as its 
parent.

Paragraph Inserts a paragraph into the report. The 
Paragraph component must have the 
Chapter/Subsection component as its parent. The 
Paragraph component can have child components, 
or it can have text. Text must be entered in the 
Paragraph Text parameter field.

Table Converts an array into a table in the report. The 
Table component can have either the 
Chapter/Subsection or Paragraph component as 
its parent and cannot have children.

Text Inserts text into the report. In general, the Text 
component should have the Paragraph component 
as its parent.

Title Page Inserts a title page at the beginning of the report. 
The Title Page component should have the Report 
component as its parent and should be the first 
component that inserts information into the 
report. This component cannot have any children. 
If your report contains a title page, it should also 
contain Chapter/Subsection components.

Component Description
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Report Generator Components
Report Generator components are general “utility” components. The following 
table describes the Report Generator components.

Component Description

Comment Inserts a comment into the DocBook source file 
created by the report generation process. The 
comment is not visible in the generated report, 
but you can edit the DocBook source file to 
make the component appear in the report.

Empty Component Does not insert anything into the report and can 
have any component as a child. It can be used to 
group components so that the components can 
be moved or activated/deactivated together, or 
it can create a blank space in a list.

Import File Imports plain text, DocBook XML, HTML, or 
RTF documents into the report.

Nest Setup File Inserts a setup file at the point where the Nest 
Setup File component is listed in the current 
setup file. The Nest Setup File component 
allows one setup file (.rpt) to run inside 
another. 

The components of the inserted setup file enter 
the current setup file at the level of the Nest 
Setup File component. Thus, the inserted 
components have the same parent component 
as the Nest Setup File component. You must 
make sure that the inserted components can 
have this parent component.
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Logic and Flow Control Components
Logical and Flow Control components execute conditionally, enabling you to 
decide when a child component executes or how many times a child component 
executes.

Logical and Flow Control components have the following parent/child 
relationships.

Stop Report Generation Halts report generation. The Stop Report 
Generation component acts like the Stop button 
during report generation, and can be used to 
halt report generation under specified 
conditions.

Time/Date Stamp Inserts the time and date of report generation. 
The Time/Date Stamp component behaves like 
a Text component; it must be inside a 
paragraph or title.

Component Description

For Loop Logical If While Loop

Logical Then Logical Else Logical Elseif
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The following table describes the Logical and Flow Control components.

Component Description

For Loop This component runs its child components iteratively. 
The For Loop component must have at least one child. 
The purpose of this component is to run its children 
several times. If it does not have any children, then this 
component does not add anything to the report.

Logical Else When the parent if condition is false, only the children 
of the else component run.

Logical Elseif When the parent if condition is false, the process checks 
all the elseif statements in order, and the children of 
the first true elseif statement run. 

Logical If if statement for report generation. When the if 
statement results in true, the component runs its child 
components.

Logical Then When the parent if condition is true, only the children of 
the then component run.

While Loop This component loops while a workspace expression is 
true. This component runs its child components until its 
conditional string is true. The number of repetitions can 
be limited to prevent infinite loops. Like the For Loop 
component, the While Loop component must have at 
least one child. If it does not have any children, then this 
component does not add anything to the report.



4 Component Reference

4-8

You can use the Logical components, including Logical If, Logical Then, Logical 
Else, and Logical Elseif, in the following ways.

Handle Graphics Components
Handle Graphics components report on Handle Graphics figures. The following 
figure shows the Handle Graphics component hierarchy. 

Component 
Used

Appearance 
in the 
Outline

How the Components Execute

Logical If if When the if condition is true, this 
component runs its children.

Logical If 
Logical Then 
Logical Else

if
then
else

- When the if condition is true, only the 
children of the then component run, 
and the process exits the if family.

- When the if condition is false, only 
the children of the else component 
run.

Logical If 
Logical Then 
Logical Elseif 
Logical Else

if
then
elseif
elseif

.

.

.
else

- When the if condition is true, only the 
children of the then component run, 
and the process exits the if family.

- When the if condition is false, the 
process checks all the elseif 
statements in order, and the children 
of the first true elseif statement run. 
The process then exits the if family. 

- If none of the elseif statements is 
true, the process runs the children of 
the else statement.

Note that only one of the conditional 
statements (then, else, elseif) actually 
executes.
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The following table describes the Handle Graphics components.

Component Description

Axes Loop Runs its child components for all 
axes objects for the current figure.

Axes Snapshot Inserts an image of the current axes 
into the generated report. 

Figure Loop Runs its children for each Handle 
Graphics figure that you select. If a 
Handle Graphics component does 
not have the Figure Loop component 
as its parent, then it operates on the 
current figure.

Figure Snapshot Inserts an image of a figure window 
into your report. The Handle 
Graphics Figure Snapshot 
component behaves like the Image 
component and expects the Figure 
Loop component as its parent.

Figure Loop

Property Table

Figure Snapshot

Name
 Parameter

Axes Loop

Object LoopAxes Snapshot

 Anchor
 Summary Table



4 Component Reference

4-10

Handle Graphics Linking Anchor Designates a location to which other 
links point. This component should 
have a looping component as its 
parent.

Handle Graphics Object Loop Runs its child components for each 
Handle Graphics object in the 
current figure or axes.

Handle Graphics Name Inserts the name of a Handle 
Graphics object into your report. The 
Handle Graphics Name component 
behaves like the Text component and 
expects the Figure Loop component 
as its parent.

Handle Graphics Property Table Creates and inserts a property 
name/property value table for 
Handle Graphics figures, axes, or 
other objects. The Handle Graphics 
Property Table component behaves 
like the Table component and 
expects the Figure Loop component, 
Axes Loop component, or Object 
Loop component as its parent.

Handle Graphics Parameter Inserts a single property 
name/property value pair from a 
Handle Graphics figure, axes, or any 
other Handle Graphics object into 
your report. 

Handle Graphics Summary Table Inserts a table that summarizes 
many Handle Graphics objects’ 
properties. You can specify the object 
properties to be included in the 
report.

Component Description
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This is an example of how Handle Graphics components can be used in a setup 
file.

Report
Figure Loop

Chapter/Subsection
Name
Anchor
Property Table
Summary Table

Axes Loop
Chapter/Subsection
Name
Anchor
Axes Snapshot
Property Table
Summary Table

Object Loop
Chapter/Subsection
Name
Anchor
Property Table
Summary Table

MATLAB Components
You can use MATLAB components to interact with the workspace. The 
following table describes the MATLAB components.

Component Description

Evaluate MATLAB Expression Evaluates a specified MATLAB 
expression. The result of the 
evaluation and/or MATLAB 
expression (M-code) can appear in 
the report.

Insert Variable Inserts a specified variable into the 
report. 
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Requirements Management Interface Component
You can use the Requirements Management Interface component to include 
information about requirements in your report.

Simulink Components
You can use Simulink components to include information on Simulink models 
in your report. Simulink components can report on four levels of a Simulink 
model: model, system, block, and signal.

Simulink components have the following parent/child relationships. 

MATLAB/Toolbox Version Number Creates a table that shows the 
version number, release number, 
and/or release date of any 
MathWorks software you are 
currently using.

MATLAB Property Table Creates a table that includes 
variables from the MATLAB 
workspace. The MATLAB Property 
Table component behaves like the 
Table component.

Variable Table Creates a table that includes all 
variables in the MATLAB 
workspace. The Variable Table 
component behaves like the Table 
component.

Component Description

Requirements Table Creates a table that contains information from 
Simulink Verification and Validation. 

Component Description



Components — Categorical List

4-13

The following table describes the Simulink components.

Component Description

Block Execution Order List Creates and inserts a list or table of 
all blocks in the model (displayed in 
order of their execution sequence) into 
the report. The Block Execution Order 
List component should have the 
Model Loop component as its parent. 
If you place this component inside the 
System Loop component, you will get 
the same list over and over again.

Model Loop

Block Execution Order List
Block Type Count
Documentation 
Functions and Variables
Property Table
Model Simulation
Summary Table
Linking Anchor
Object Property
System Hierarchy
Model Change Log
Library Information

Documentation 
Linking Anchor
Name
Object Property
Summary Table
Name
System Filter
System Hierarchy
System Property Table
System Snapshot

System Loop

Block Loop Signal Loop

Simulink Automatic Table
Block Property Table
Linking Anchor
Name
Object Property

Property Table
Linking Anchor
Name
Object Property
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Block Loop Specifies the blocks to be included in 
the report. The Block Loop 
component can have the Model Loop, 
System Loop, or Signal Loop 
component as its parent.

Block Type Count Counts the number of each block type 
in a model or system. The Simulink 
Block Type Count component can 
have either the Model Loop or the 
System Loop as its parent.

Model Change Log Constructs a model history table that 
displays information about each 
logged revision to a model. This 
component must be executed before 
the Model Simulation component.

Model Loop Runs its child components for all 
selected Simulink models and 
systems. The Model Loop component 
can run its child components for a 
specific model, all models, or the 
current model.

Model Simulation Simulates the current Simulink 
model. The Model Simulation 
component expects the Model Loop 
component as its parent.

Signal Loop Runs its child components for each 
signal in its parent loop. The Signal 
Loop component can have the Model 
Loop, System Loop, or Block Loop 
component as its parent.

Simulink Automatic Table Creates a two-column property 
name/property value table.

Component Description
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Simulink Functions and Variables Inserts a table listing all workspace 
variables and functions used by the 
blocks that are reported on in the 
current model. The Simulink 
Functions and Variables component 
expects the Model Loop component, 
System Loop component, or Block 
Loop component as its parent.

Simulink Library Information Inserts a table listing all blocks, 
libraries, reference blocks, and link 
status for the current model.

Simulink Linking Anchor Acts like a link in a paragraph or 
title. This component can have any 
Simulink looping component as its 
parent.

Simulink Name Inserts the name of the current 
system, model, block, or signal, 
according to the option you specify. 
The Simulink Name component can 
have any Simulink looping 
component as its parent. This 
component behaves like the Text 
component.

Simulink Property Inserts a single property 
name/property value pair for a 
Simulink object as text. The Simulink 
Property component can have any 
Simulink looping component as its 
parent. 

Component Description
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Simulink Property Table Inserts a property name/property 
value table for the model, system, 
block, or signal specified by the Model 
Loop component. The Simulink 
Property Table component has the 
Model Loop component as its parent.

Simulink Summary Table Inserts a table that lists several 
Simulink objects and their properties. 
The Simulink Summary Table 
component can have the Model Loop 
as its parent if you are creating the 
table for systems, blocks, or signals. If 
you are creating the table for blocks 
and signals, then the System Loop 
component can be its parent.

System Filter Runs its children only if certain 
conditions are met by the current 
system. The System Filter component 
expects the System Loop component 
as its parent.

System Hierarchy Inserts a list of the names of parent 
and child systems in the current 
system; child systems are shown 
indented under the parent systems. 
The System Hierarchy component 
can have either the Model Loop or 
System Loop component as its 
parent.

System Loop Runs its child components for each 
system defined in the Model Loop 
component. The System Loop 
component must have the Model Loop 
component as its parent.

Component Description
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Simulink Blocks Components
You can use the Simulink Blocks components to include information in the 
generated report about specific Simulink block types. Simulink Blocks 
components can be used in model, system, or block loops to report on block 
types in context. 

The following table describes the Simulink Blocks components.

System Snapshot Inserts a picture of the current 
system into the report. The current 
system is defined by the System Loop 
component. The System Snapshot 
component should have the System 
Loop component as its parent.

Component Description

Bus Creates a list of all signals exiting from a 
Bus Selector block. The list can contain only 
those signals leaving from the reported 
block or it can be hierarchical and display 
downstream buses and signals.

Documentation Inserts text extracted from doc blocks in 
Simulink models. The Documentation 
component can have the Model Loop, the 
System Loop, or the Block Loop as its 
parent.

Look-Up Table Reports on lookup table blocks; it inserts a 
figure and/or table into the report. The 
table contains input and output numeric 
values, and the figure is a plot of the values.

Component Description
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Stateflow Components
You can use Stateflow components to include information on Stateflow models 
in your report. The following figure shows the parent/child relationships of 
Stateflow components.

Scope Snapshot Inserts a snapshot of all scope blocks and 
XY plots in your report. The Scope 
Snapshot component can have any 
Simulink looping component as its parent.

To Workspace Plot Captures a plot created in the MATLAB 
workspace. This component inserts a figure 
and/or table into the report. The table 
contains input and output numeric values 
and the figure is a plot of the values.

Component Description
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The following table describes the Stateflow components.

Component Description

Chart Loop Runs its children for each Stateflow chart 
that you choose. The Chart Loop component 
can have the Simulink Model Loop, System 
Loop, Signal Loop, or Block Loop component 
as its parent. 

Machine Loop Runs its child components for all selected 
Stateflow machines. The Machine Loop 
component can run its child components for 
a specific machine, all machines, or the 
current machine.

State Loop

Property Table

Model/System Loop

Hierarchy
Count

Anchor
Name

Snapshot
Automatic Table
Summary Table
Truth Table
Property

Hierarchy Loop

Machine Loop

Stateflow Filter

Chart Loop

Object Loop

Summary Table



4 Component Reference

4-20

Stateflow Count Counts the number of Stateflow objects in 
the current system. See the Stateflow 
documentation for a description of 
Stateflow objects.

Stateflow Filter Runs its children only if the current object 
type (set by the parent State Loop) matches 
the component’s object type. The Stateflow 
Filter component must have the Stateflow 
Loop component as its parent.

State Loop Runs its children for each Stateflow object 
defined by its parent component. The State 
Loop component must have the Model Loop, 
System Loop, Signal Loop, Block Loop, 
Chart Loop. or Machine Loop component as 
its parent.

Stateflow Automatic Table Inserts a table that contains the properties 
of a Stateflow object.

Stateflow Hierarchy Loop Runs its child components on the entire 
Stateflow object hierarchy from the current 
point down.

Stateflow Linking Anchor Acts like a link. This component must have 
the State Loop, Chart Loop, or Stateflow 
Filter component as its parent.

Stateflow Name Inserts the name of the Stateflow object 
specified by its parent component into the 
report. This component must have the State 
Loop, Chart Loop, or Stateflow Filter 
component as its parent.

Stateflow Hierarchy Inserts a tree representation into a 
generated report that describes the 
Stateflow object hierarchy.

Component Description
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Simulink Fixed Point Blockset Components
You can use Simulink Fixed Point Blockset components to include information 
on Simulink Fixed Point blocks in your report. The following figure shows the 
parent/child relationships of the Simulink Fixed Point Blockset components.

Stateflow Object Loop Runs its child components for each terminal 
Stateflow object. The component inserts a 
list of object types.

Stateflow Property Inserts a table, text, or paragraph that 
contains details of the selected Stateflow 
object property.

Stateflow Property Table Inserts a property name/property value 
table for a Stateflow object into the report. 
The Stateflow Property Table component 
must have the Stateflow Filter component 
as its parent.

Stateflow Snapshot Inserts an image of a Stateflow object into 
the report. The Stateflow Snapshot 
component is only valid for certain object 
types.

Stateflow Summary Table Shows properties or parameters of the 
selected Stateflow objects in a table. The 
Stateflow Summary Table component can 
have the Chart Loop or any Simulink 
looping component (Model Loop, System 
Loop, Block Loop, State Loop, or Signal 
Loop) as its parent.

Truth Table Inserts a table. The component must have 
the State Loop component as its parent.

Component Description
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The following table describes the Simulink Fixed Point Blockset components.

Component Description

Fixed Point Block Loop Runs its children for the Simulink 
model, system, or signal defined by its 
parent component. For example, if the 
Fixed Point Block Loop is parented by 
the Simulink Model Loop, it runs its 
children for all fixed-point blocks in the 
Simulink model. The Fixed Point Block 
Loop component can have either the 
Simulink Model Loop, System Loop, or 
Signal Loop component as its parent.

Fixed Point Logging Options Sets fixed-point options similar to those 
set in the Fixed Point Settings interface. 
You can use this component before a 
Model Simulation component in order to 
control how the model behaves during 
simulation.

Fixed Point Block Loop Fixed Point Logging Options

Fixed Point Property Table Fixed Point Summary Table
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Fixed Point Property Table Inserts a property name/property value 
table for a fixed-point block. The Fixed 
Point Property Table component must 
have the Fixed Point Block Loop 
component as its parent.

Fixed Point Summary Table Shows properties or parameters of the 
selected fixed-point blocks in a table. 
The Fixed Point Summary Table 
component must have the Fixed Point 
Block Loop as its parent.

Component Description
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Components — Alphabetical List 4

This section contains component reference pages listed alphabetically.
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4Axes LoopCategory Handle Graphics

Description The Axes Loop component runs its child components for all axes objects in the 
MATLAB workspace. For more information about working with looping 
components, see “Working with Looping Components” on page 3-20.

Attributes The following figure shows the Axes Loop properties panel:

Object 
Selection

Loop type
To loop on all axes objects, select All axes. To loop on the selected axes 
object, select Current axes. 

Exclude objects which subclass axes
Select this option to exclude objects such as legends and color bars.

Loop Menu
To loop only on visible axes objects, select Loop on axes with handle 
visibility "on". To loop on all axes objects, select Loop on all axes.
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Search terms
Enter search terms for the loop. For example, to search for Tag and My 
Data, enter "Tag", "My Data".

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, inserts a section if the Create section for each object in loop option is 
selected.

Filename rptgen_hg.chg_ax_loop
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4Axes SnapshotCategory Handle Graphics

Description The Axes Snapshot component inserts an image of the selected axes objects in 
MATLAB into the generated report. 

Attributes The following figure shows the Axes Snapshot properties panel:

Format Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic HG Format to automatically choose the format best suited for 
the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic HG 
Format is the default option. The options include

- Automatic HG Format (uses the Handle Graphics file format selected in 
the Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
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- Bitmap (256-color)
- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed

- Windows metafile

Capture figure from screen
Select this option to capture the figure for the generated report directly 
from the screen. This option executes faster, but is not applicable for all 
formats. Also, the image to be captured might be obscured by other 
windows on the screen.

Print Options Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use figure orientation option. For information 
about paper orientation, see the reference page for the orient command.

Image size
Select Use figure PaperPositionMode setting to use the 
PaperPositionMode property of the Handle Graphics figure to set the 
image size in the report. See the orient command for information about 
paper position mode.
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Select the Automatic (same size as onscreen) option if you want the 
image in your report to be the same size as the image on the screen.

Select the Custom option to choose a custom image size. If you choose this 
option, specify the image size in the Size field and Units list.

- Size: Enter the size of the Handle Graphics figure snapshot in the form 
[w h] (width height). This field is active only if you choose Custom in the 
Image size list box.

- Units: Enter the units for the size of the Handle Graphics figure snapshot. 
This field is active only if you choose Set image size in the Custom list 
box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This 
parameter inverts colors for printing; i.e., it changes dark colors to light 
colors and vice versa. 

Select one of the following options:

- Automatic — Select this option to automatically change dark axes colors 
to a light axes color. If the axes color is a light color, then it is not inverted.

- Invert — Select this option to change dark axes colors to light axes colors 
and vice versa. 

- Don't invert — Select this option if you do not want to change the colors 
in the image displayed on the screen for printing.

- Use figure's InvertHardcopy setting — Select this option to use the 
InvertHardcopy property set in the Handle Graphics image.

- Make figure background transparent — Select this option to make the 
image background transparent.

Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.
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Insert Anything 
into Report?

Yes. Image.

Filename rptgen_hg.chg_ax_snap
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4Block Execution Order ListCategory Simulink

Description The Block Execution Order List component creates a list or table of all 
nonvirtual blocks in the model, showing the order in which they are executed. 
See the Simulink documentation for a definition and a list of virtual and 
nonvirtual blocks.

Attributes The following figure shows the Block Execution Order List properties panel:

List Title
To generate a title automatically, select Automatic. To enter a custom title, 
select Custom. Enter a title in this field if you want to have a title for the 
table or list. If you have a title for a table, it is included in the List of Tables 
if the stylesheet you chose in the Report Options attribute page supports it. 

Include block type information
Select this option if you want to include each block’s BlockType property in 
the list or table.
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Look under nonvirtual subsystems
- On

- Off

- Automatic (On for models, Off for systems)

For example, the Simulink model Demo_System appears similar to the following 
figure:

Insert Anything 
into Report?

Yes. List.

Filename rptgen_sl.csl_blk_sort_list
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4Block LoopCategory Simulink

Description The Block Loop component runs its child components for each block contained 
in the current system, model, or signal. For more information about working 
with looping components, see “Working with Looping Components” on 
page 3-2.

Attributes The following figure shows the Block Loop properties panel:

Report On This pane describes what the Block Loop component is operating on.

Automatic list from context
Select this option to report on all blocks in the current context. The context 
is set by the Block Loop component’s parent component:

- If the parent component is the Model Loop, then selecting this option 
causes the Block Loop component to report on all blocks in the current 
model.
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- If the parent component is a System Loop, then selecting this option 
causes the Block Loop component to report on all blocks in the current 
system.

- If the parent component is the Signal Loop, then selecting this option 
causes the Block Loop component to report on all blocks connected to the 
current signal.

- If the Block Loop does not have the Model Loop, System Loop, Signal Loop, 
or Block Loop component as its parent, then selecting this option causes 
the Block Loop component to report on all blocks in all models.

Custom - use block list
Select this option to report on a list of blocks that you specify and enter the 
block names in the corresponding field. You must use the full pathname 
when specifying blocks. If you want to sort the blocks in this list, select the 
Sort blocks in list option and then select a sorting option from the Sort 
blocks option (in the Loop Options section). Blocks are reported on in the 
order that they are sorted. If you do not select this option, blocks are 
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details.

For example, if you want to report on the theta dot integrator block and 
the theta integrator block in the demo model simppend, you could enter the 
following in the block list.

simppend/theta dot

%<Z>

If you define Z in the workspace as the following,

Z={'simppend/theta'}

then the Report Generator reports on the following blocks.

simppend/theta dot

simppend/theta

Loop Options You can choose block sorting options and reporting options in this pane.
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Sort blocks
Use this option to select how the blocks are sorted:

- Select Alphabetically by block name to sort blocks alphabetically by 
their names.

- Select Alphabetically by system name to sort systems alphabetically.

In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select Alphabetically by full Simulink path to sort blocks 
alphabetically by Simulink path.

- Select By block type to sort blocks alphabetically by block type.

- Select By block depth to sort blocks by their depth in the model.

- Select By traversal order to sort blocks by traversal order. 

- Select By simulation order to sort blocks by execution order.

Search for property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields. 

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each block 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the block in the generated report.

Insert Anything 
into Report?

Yes, inserts section if the Create section for each object in loop option is 
selected.

Filename rptgen_sl.csl_blk_loop
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4Block Type CountCategory Simulink

Description The Block Type Count component counts the number of each block type in the 
current model or system. See the Simulink documentation for a description of 
block type.

Attributes The following figure shows the Block Type Count properties panel:

Count Types This pane describes where block types are being counted.

• If the Block Type Count component has the Model Loop as its parent, it 
reports all block types in the current model.

- Use the All blocks in model option to count block types in the entire 
model.

- Use the All blocks in reported systems option to count block types only 
in systems that are included in the report.
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• If the Block Type Count component has the System Loop as its parent, it 
reports all block types in the current system.

• The Block Loop and the Signal Loop components are not valid parents for the 
Block Type Count component.

Table Content Table title
Enter the title of the table in this field.

Show block names in table
Select this option to include a column that displays all block names in the 
table.

Sort table
To sort blocks alphabetically by block type, select Alphabetically by 
block type.

To sort by decreasing number of occurrences, select By number of blocks.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sl.csl_blk_count
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4BusCategory Simulink Blocks

Description The Bus component creates a list of all signals exiting from a Bus Selector 
block. The list can contain only those signals leaving from the reported block or 
it can be hierarchical and display downstream buses and signals.

When working with the Bus component, keep the following points in mind:

• If the Bus component has the Model Loop as its parent, it includes all buses 
in the current model.

• If the Bus component has the System Loop as its parent, it includes all buses 
in the current system.

• If the Bus component has the Block Loop as its parent, it includes the current 
block if it is a bus.

• If the Bus component has the Signal Loop as its parent, it includes all buses 
connected to the current signal.

• If the Bus component does not have any of the Simulink looping components 
as its parent, it includes all buses in all open models.

Attributes The following figure shows the Bus properties panel:
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Show Bus Hierarchy
Use this option to specify whether or not the list should display 
downstream buses in a hierarchical form.

Hierarchical list:

List Title
Bus Selector
signal3
signal2
signal4

Bus Selector1
signal3
Bus Selector2

signal2
signal1

Bus Selector3
signal2
signal1

Nonhierarchical list:

List Title
Bus Selector
signal3
signal2
signal4

List Title
Bus Selector1
signal3

List Title
Bus Selector2
signal2
signal1

List Title
Bus Selector3
signal2
signal1



Bus

4-42

Insert linking anchor for bus blocks
When this option is selected, the Report Generator inserts a linking anchor 
for each bus block. This designates the list item as the location to which 
other links for that block will point. (See the Simulink Linking Anchor or 
Link components for more help.) You should not use this option if you have 
already specified an anchor location for the bus block with an Object 
Linking Anchor component.

Insert linking anchor for signals
When this option is selected, the Report Generator inserts a linking anchor 
for each signal. This designates the list item as the location to which other 
links for that signal will point. (See the Simulink Linking Anchor or Link 
components for more help.) You should not use this option if you have 
already specified an anchor location for the signal with an Object Linking 
Anchor component.

Title
Use this option to insert a title before each list. Note that this attribute 
supports the %<varname> notation.

Insert Anything 
into Report?

Yes. List.

Filename rptgen_sl.csl_blk_bus
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4Chapter/SubsectionCategory Formatting

Description The Chapter/Subsection component groups portions of the report into sections. 
Each section has a title and some content. The following rules apply to the 
Chapter/Subsection component:

• Children of the Chapter/Subsection component are placed inside the section 
created by this component.

• The Chapter/Subsection component takes paragraph-level children unless 
you select the Get title from first child component check box. In this case, 
a Chapter/Subsection component’s first child must be a Text component. 

• The Chapter/Subsection component can be the child of another 
Chapter/Subsection component.

Sections can be nested, and titles automatically become smaller inside 
subsections. There are seven levels of nesting possible.

Chapter
Section 1

Section 2
Section 3

Section 4
Section 5

Section 6
No Section

Any Chapter/Subsection components beyond the sixth section do not create a 
titled section, although the child components of these sections do insert 
information into the report.

Chapter Numbering
By default, chapters are numbered and sections are not numbered. Chapter 
and section numbering are specified by the stylesheet you choose in the Report 
Options attribute page. See “Setting the Report Format” on page 2-3 for 
chapter and section numbering options in Web and print stylesheets.

Attributes The following figure shows the Chapter/Subsection properties panel:
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Section Title Title
Choose a title for the display in the generated report. To generate a title 
automatically, select Automatic. To enter a title, select Custom. 

Numbering
Choose a numbering style for the report. To number by context, select 
Automatic. To create your own numbering style, select Custom.

Section Type
The item in the Section Type pane shows you what level the selected 
section is residing in.

Insert Anything 
into Report?

Yes. Chapter or section.

Filename rptgen.cfr_section
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4Chart LoopCategory Stateflow

Description The Chart Loop component runs its children for each Stateflow chart that you 
choose. The Chart Loop component can have the Model Loop, System Loop, 
Signal Loop, or Block Loop component as its parent. 

Attributes The following figure shows the Chart Loop properties page.

Report On Automatic list from context
Select this option to report on all charts in the current context. The context 
is set by the Chart Loop component's parent component: 

- If the parent component is the Model Loop, then selecting this option 
causes the Chart Loop component to report on all reported Stateflow 
charts in the current model. 



Chart Loop

4-46

- If the parent component is the System Loop, then selecting this option 
causes the Chart Loop component to report on all Stateflow charts in the 
current system. 

- If the parent component is the Signal Loop, then selecting this option 
causes the Chart Loop component to report on all Stateflow charts 
connected to the current signal. 

- If the parent component is the Machine Loop, then selecting this option 
causes the Chart Loop component to report on the current Simulink block 
if it is a Stateflow chart. 

- If the Chart Loop does not have the Model Loop, System Loop, Signal Loop, 
or Block Loop component as its parent, then selecting this option causes 
the Chart Loop component to report on all Stateflow charts.

Custom - use chart list
Select this option to report on a list of Stateflow charts that you specify, and 
enter the chart names in the corresponding field. If you want to sort the 
charts in this list, select the Sort charts in list option and then select a 
sorting option from the Sort charts option (in the Loop Options section). 
Charts are reported on in the order that they are sorted. If you do not select 
this option, charts are reported on in the order that they are listed in the 
chart list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details and the Custom - use block list section in the 
Simulink Block Loop reference page for an example.

Loop Options
You can choose chart sorting options and reporting options in this pane.

Sort charts
Use this option to select how the blocks are sorted (this option is available 
if you select the Automatic list from context option in the Report On 
section or if you select Custom  - use chart list and the Sort charts 
option):

- Select Alphabetically by block name to sort blocks alphabetically by 
name.
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- Select Alphabetically by system name to sort systems alphabetically by 
name.

- In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select Alphabetically by full Simulink path to sort models 
alphabetically by their full path name.

- Select By block type to sort blocks alphabetically by block type.

- Select By depth to sort blocks by their depth in the model.

- Select By simulation order to sort blocks by execution order.

Search Stateflow
Select this option to report only on Stateflow charts with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields. 

Section 
Options

Create section for each object in loop
Select this option to insert a section for each object found in the loop in the 
generated report.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, inserts section if the Create section for each object in loop option is 
selected.

Filename rptgen_sf.csf_chart_loop
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4CommentCategory Report Generator

Description The Comment component inserts a comment into the XML source file created 
by the report generation process. The comment is not visible in the generated 
report.

This component can have children. Child components insert their output into 
the XML source file, but this output appears inside comment tags and does not 
appear in the final report.

If you want the comment text to appear in the report, follow these steps:

1 Edit the XML source file (the XML source file has the same name as your 
report file, but has a .xml extension). Note that you must generate a report 
to create the XML source file.

2 Find the comment area in the XML source file by locating the comment tags 
<-- and -->. Remove both of these tags.

3 Convert the XML source file using the rptconvert command (For more 
details on the rptconvert command, see “Converting XML Documents” on 
page 2-7).

Attributes The following figure shows the Comment properties panel:
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Comment text
Enter the comments that you want to include in the report.

Show comment in Generation Status window
Select this option if you want to display the comment in the Generation 
Status tab when the report is generating.

Status message priority level
This option is only available if you select the Show comment in 
Generation Status window option. Select the status message priority 
level that is displayed during report generation. 

Insert Anything 
into Report?

No, but this component inserts a comment into the XML source file, which can 
appear in the report.

Filename rptgen.crg_comment
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4DocumentationCategory Simulink Blocks

Description The Documentation component inserts text extracted from doc blocks in 
Simulink models. The Documentation component can have either the Model 
Loop, the System Loop, or the Block Loop component as its parent. If the report 
format is set to HTML, you can import HTML documentation. If the report 
format is set to RTF, you can import RTF documentation.

Attributes The following figure shows the Documentation properties panel:

Import file as

• Plain text (ignore line breaks): Select this option to import plain text 
without any line breaks (no paragraphs). 

In this example and subsequent examples, the following text is used as the 
input text. 
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This is the first row of imported text from the doc block.
The second row follows a line break in the first row.

There is a blank line above the third row.

With the Plain text (ignore line breaks) option, the following is 
produced.

This is the first row of imported text from the doc block. The 
second row follows a line break in the first row. There is a blank 
line above the third row. 

• Paragraphs defined by line breaks: Select this option to import the text 
contained in paragraphs defined by line breaks (hard returns or carriage 
returns).

With the Paragraphs defined by line breaks option, the following is 
produced.

This is the first row of imported text from the doc block.
The second row follows a line break in the first row.
There is a blank line above the third row. 

• Paragraphs defined by empty rows: Select this option to import text 
contained in paragraphs defined by empty rows (rows that do not contain 
text).

With the Paragraphs defined by empty rows option, the following is 
produced.

This is the first row of imported text from the doc block. The 
second row
follows a line break in the first row.
There is a blank line above the third row. 
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• Text (retain line breaks): Select this option to import plain text, 
including line breaks.

With the Text (retain line breaks) option, the following is produced.

This is the first row of imported text from the doc block.
      The second row follows a line break in the first row.
There is a blank line above the third row.

• Fixed-width text (retain line breaks): Select this option to import 
fixed-width text (all letters have the same width or size) including line 
breaks. This option is best suited for importing M-files.

With the Fixed-width text (retain line breaks) option, the following is 
produced.

This is the first row of imported text from the doc block.
      The second row follows a line break in the first row.

There is a blank line above the third row.

Insert linking anchor for blocks 
Select this option to insert a linking anchor for each doc block. This 
designates the location to which other links for that block will point. (See 
the Simulink Linking Anchor or Link components for more help.) You 
should not use this option if you have already specified an anchor location 
for the doc block with an Object Linking Anchor component.

Insert Anything 
into Report?

Yes. Text, paragraph, or external RTF/HTML.

Filename rptgen_sl.csl_blk_doc
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4Empty ComponentCategory Report Generator

Description The Empty Component does not insert anything into the report and can have 
any component as a child. You can use it to group components together so that 
the components can be moved or activated/deactivated easily, or to create a 
blank space in a list.

If the Report Generator does not recognize a component when loading a setup 
file, it replaces the unrecognized component with the Empty Component.

Attributes The following figure shows the Empty Component properties panel:

Insert Anything 
into Report?

No.

Filename rptgen.crg_empty
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4Evaluate MATLAB ExpressionCategory MATLAB

Description The Evaluate MATLAB Expression component evaluates a specified MATLAB 
expression in the workspace. The code and/or command line output can be 
inserted into the report.

Attributes The following figure shows the Evaluate MATLAB Expression properties 
panel:

Insert MATLAB expression in report
Select this option if you want the MATLAB expression that is evaluated by 
this component to appear in the report.

Display command window output in report
Select this option if you want to include the command window output that 
results when the MATLAB expression is evaluated.

Expression to evaluate in the base workspace
Enter the expression that you want to evaluate in the MATLAB workspace.
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Evaluate this expression if there is an error
Select this option if you want to evaluate another MATLAB expression if 
the evaluated expression produces an error. Enter the expression that 
should be evaluated in case of an error in this field.

Insert Anything 
into Report?

Inserts text if you select one of the following options:

• Insert MATLAB expression string in report
• Display command window output in report

Otherwise, this component does not insert anything into the report.

Filename rptgen.cml_eval
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4Figure LoopCategory Handle Graphics

Description The Figure Loop component applies each child component to graphics figures 
specified in the attribute page.

See “Working with Looping Components” on page 3-2 for a  discussion of this 
component.

Attributes The following figure shows the Figure Loop properties panel:

Figure 
Selection

You can choose to loop on

• The current figure

• All visible figures

• Figures with certain tags

Include figures
To include only the current figure in the report, select the Current figure 
only option. 
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To loop on all visible figures, select the Visible figures option. This 
option executes child components for all figures that are currently open and 
visible. The Data figures only option is checked by default and excludes 
figures with HandleVisibility = 'off' from the loop.

To loop on figures with certain tags, select the All figures with tags 
option. When you are selecting a tag, all figures with that tag are included, 
regardless of whether the figure is visible or whether HandleVisibility is 
'on' or 'off'. The tag list box (located under the All figures with tags 
option) shows the selected tags. To add a tag to the tag list box, select the 
tag from the list on the right and click the Add button. The tag list shows 
a list of tags for figures that are open. If you want to add a tag that does not 
appear in the tag list, you can type in the tag.

Loop Figure List
The Loop Figure List shows you the figures that would be looped on given 
the current set of figures.

Note  If your setup file generates new figures or changes existing figures, 
then the figures in the Loop Figure List will not be the figures that are 
actually reported on.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is selected.

Filename rptgen_hg.chg_fig_loop
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4Figure SnapshotCategory Handle Graphics

Description The Figure Snapshot component inserts a snapshot of a Handle Graphics 
figure.

Attributes The following figure shows the Figure Snapshot properties panel:

Format Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.,) from this list. Select 
Automatic HG Format to automatically choose the format best suited for 
the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic HG 
Format is the default option. The options include

- Automatic HG Format (uses the Handle Graphics file format selected in 
the Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
- Bitmap (256-color)
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- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed
- Windows metafile

Capture picture from screen
Use the option to capture a figure from the screen.

Print Options Use the attributes in this section to set printing parameters.

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use figure orientation option. See the orient 
command for information about paper orientation.

Image size
Select Use figure PaperPositionMode setting to use the 
PaperPositionMode property of the Handle Graphics figure to set the 
image size in the report. See the orient command for information about 
paper position mode.

Select the Automatic (same size as on screen) option if you want the 
image in your report to be the same size as the image on the screen.
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Select the Custom option to choose a custom image size. If you choose this 
option, specify the image size in the Size field and Units list.

- Size: Enter the size of the Handle Graphics figure snapshot in the form 
wxh (width times height). This field is active only if you choose Custom in 
the Image size list box.

- Units: Enter the units for the size of the Handle Graphics figure snapshot. 
This field is active only if you choose Custom in the Image size list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This 
parameter inverts colors for printing; i.e., it changes dark colors to light 
colors and vice versa. 

Select one of the following options:

- Automatic — Select this option to automatically change dark axes colors 
to a light axes color. If the axes color is a light color, then it will not be 
inverted.

- Invert — Select this option to change dark axes colors to light axes colors 
and vice versa. 

- Don't invert — Select this option if you do not want to change the colors 
in the image displayed on the screen for printing.

- Use figure's InvertHardcopy setting — Select this option to use the 
InvertHardcopy property set in the Handle Graphics image.

- Make figure background transparent — Select this option to make the 
image background transparent.

Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.

Insert Anything 
into Report?

Yes. Image.

Filename rptgen_hg.chg_fig_snap
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4Fixed Point Block LoopCategory Simulink Fixed Point Blockset

Description The Fixed Point Block Loop component runs its children for the Simulink 
model, system, or signal defined by its parent component. For example, if the 
Fixed Point Block Loop is parented by the Simulink Model Loop, it runs its 
children for all fixed-point blocks in the Simulink model. The Fixed Point Block 
Loop component can have the Simulink Model Loop, System Loop, or Signal 
Loop component as its parent.

Attributes The following figure shows the Fixed Point Block Loop properties panel:

Report On Automatic list from context
Select this option to report on all fixed-point blocks in the current context. 
The context is set by the Fixed Point Block Loop component’s parent 
component. For example, if the parent component is the Simulink System 
Loop, then this component reports on all fixed-point blocks in the current 
system.
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If the Fixed Point Block Loop component does not have a Simulink Model 
Loop, System Loop, Block Loop, or Signal Loop component as its parent, 
then selecting this option causes the component to report on all fixed-point 
blocks in all models. 

Custom - use block list
Select this option to report on a list of blocks that you specify, and enter the 
block names in the corresponding field. If you want to sort the blocks in this 
list, select the Sort blocks in list option and then select a sorting option 
from the Sort blocks list (in the Loop Options section). Blocks are 
reported on in the order that they are sorted. If you do not select this option, 
blocks are reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details.

For example, if you want to report on the A2D block and the D2A block in the 
demo model fxpdemo_feedback, you could enter the following in the block 
list:

A2D

Z

If you define Z in the workspace as the following,

Z={'fxpdemo_feedback/D2A'}

then the Report Generator will report on the following blocks,

A2D

D2A

Loop Options You can choose block sorting options and reporting options in this pane.

Sort blocks
Use this option to select how the blocks are sorted (this option is available 
if you select the Automatic list from context option in the Report On 
section or if you select Custom - use block list and the Sort blocks 
option):
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- Select Alphabetically by fixed point block name to sort blocks 
alphabetically by their names.

- Select Alphabetically by system name to sort systems alphabetically.

In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select By fixed point block type to sort blocks alphabetically by block 
type.

- Select By fixed point block depth to sort blocks by their depth in the 
model.

- Select By simulation order to sort blocks by execution order.

Search for property name/property value pairs
Select this option to report only on fixed-point blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields. 

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, inserts section if the Create section for each object in loop option is 
selected.

Filename rptgen_fp.cfp_blk_loop
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4Fixed Point Logging OptionsCategory Simulink Fixed Point Blockset

Description The Fixed Point Logging Options component sets fixed-point options similar to 
those set in the Fixed Point Settings interface. You can set the following 
options with this component:

• Logging options

• Doubles override

• Log mode

You can use this component before a Model Simulation component in order to 
control how the model behaves during simulation.

Attributes The following figure shows the Fixed Point Logging Options properties 
panel:

Log Min and 
Max

You can select logging minimum and maximum options in this section. If a 
fixed-point block is logged, minimum and maximum simulation values are 
logged to the workspace. See the Simulink Fixed Point documentation for more 
information about logging simulation results.

All fixed point blocks
Select this option to log all fixed-point blocks.
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No logging
Select this option if you do not want to any fixed-point block to be logged.

Use block “dolog” parameter
Select this option to use the fixed-point blocks’ dolog parameters.

Doubles 
Override

You can select whether you want to override the fixed-point blocks’ parameters 
and output data types with doubles, i.e, represent the parameters and outputs 
using double-precision floating-point numbers and perform all calculations 
with floating-point arithmetic. See the Simulink Fixed Point documentation 
for more information about overriding with doubles.

All fixed point blocks
Select this option to override the output data type with doubles. 

No doubles
Select this option to have no output data types that are doubles.

Use block DblOver parameter
Select this option to use the fixed-point blocks’ DblOver parameters. 

Log Mode Select how you want logs to be recorded in this section.

Override log
Select this option if you want all simulation logs to overwrite the previous 
simulation logs. 

Merge log
Select this option if you want to append all simulation logs to the previous 
simulation logs. 

Insert Anything 
into Report?

No.

Filename rptgen_fp.cfp_options
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4Fixed Point Property TableCategory Simulink Fixed Point Blockset

Description The Fixed Point Property Table inserts a table that reports on fixed-point block 
property name/property value pairs.

Attributes The following figure shows the Fixed Point Property Table properties panel:

Table A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table list in the upper left corner of the attributes 
page. To apply a preset table, select the table and click Apply.

Preset table
Choose a type of table to display the object property table:

- Defaults
- Callbacks
- Graphics
- Printing
- Blank 4x4

Split property/value cells
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Select this option to split property name/property value pairs into separate 
cells. To have the property name and property value appear in adjacent 
horizontal cells in the table, select the Split property/value cells check 
box. In this case, the table is in split mode and there can be only one 
property name/property value pair in a cell. If you have more than one 
name/property pair in a cell, then only the first pair is displayed in the 
report. All subsequent pairs are ignored.

To have the property name and property value appear together in one cell, 
deselect the Split property/value cells. This is nonsplit mode. In  nonsplit 
mode, you can have more than one property name/property value pair and 
you can also have text.

If you want to switch from nonsplit mode to split mode, make sure that you 
have only one property name/property value pair per table cell before you 
switch modes. If you have more than one property name/property value 
pair or any text, then only the first property name/property value pair 
appears in the report; subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the generated 
report.

Table Cells
Use this field to select table properties to modify. The selection in this pane 
affects the available fields in the Cell Properties pane.

Title Properties Contents
Use this field to modify the contents of the table cell selected in the Table 
Cells pane.

Show as
Choose the format for the contents of the table cell:

- Value
- Property Value
- PROPERTY Value
- Property: Value
- PROPERTY: Value
- Property - Value
- PROPERTY - Value
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Creating Custom Tables
To create a custom table, you can first select a preset table and then edit it. You 
might want to start with the Blank 4x4 preset table. You can add and delete 
rows and you can add properties. To open the Edit Table dialog box, click the 
Edit button. The dialog box appears:

For more information about using this dialog box to create custom property 
tables, see “Working with Property Table Components” on page 3-11.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_fp.cfp_prop_table
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4Fixed Point Summary TableCategory Simulink Fixed Point Blockset

Description The Fixed Point Summary Table component shows properties or parameters of 
the selected fixed-point blocks in a table.

Attributes The following figure shows the Fixed Point Summary Table properties panel:

Table title
Choose a title for the summary table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Property 
Columns

Property columns
This figure displays the object properties to be included in the summary 
table in the generated report. To add a property, select the appropriate 
property level in the menu. Next, in the contextual list below the menu, 



Fixed Point Summary Table

4-70

select the property that you want to add and click the Add button . To 
delete a property, select the property name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary table in 
the generated report. Entered widths should be in percentages.

Object Rows Insert anchor for each row
Select this option to insert an anchor for each row in the summary table.

Report On
Use this option to select the blocks that are reported on.

- Automatic list from context — Select this option to report on all blocks 
in the current context.

- Custom  use block list — Select this option to report on a list of blocks 
that you specify, and enter the block names in the corresponding field. You 
must use the full pathname when specifying blocks.

Loop Options Sort blocks
Use this option to select how the blocks are sorted:

- Select Alphabetically by block name to sort blocks alphabetically by 
their names.

- Select Alphabetically by system name to sort systems alphabetically.

In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select Alphabetically by full Simulink path to sort blocks 
alphabetically by Simulink path.

- Select By block type to sort blocks alphabetically by block type.

- Select By block depth to sort blocks by their depth in the model.

- Select By traversal order to sort blocks by traversal order. 

- Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.
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Insert Anything 
into Report?

Yes. Table.

Filename rptgen_fp.cfp_summ_table
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4For LoopCategory Logical and Flow

Description The For Loop component iteratively executes its child components and must 
have at least one child component to execute properly. This component 
functions like the for loop in MATLAB, except that instead of executing a 
statement, it executes its child components while one of the following loops is 
active:

for varname=x:y:z

for varname=[a b c ...]

where varname must be a string that is valid as a variable name. x, y, z can be 
scalar numbers or workspace expressions that are evaluated in the workspace 
as scalar numbers. If any one of these is a string that cannot be evaluated as a 
scalar number, then the For Loop does not execute.

For example, if red is a workspace variable, the following is a valid for 
statement.

for i=1:1:length(red)

length(red) is 3, which is a scalar number.

Attributes The following figure shows the For Loop properties panel:
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Loop Type In this section you can choose the loop type to be incremented indices or a 
vector of indices. See the MATLAB documentation for more details on the for 
loop and indices.

Incremented indices
Choose this option to execute a for loop of the following form:

for varname=x:y:z

Enter the appropriate values in the following fields:

- Start corresponds to x in the for loop shown above.

- Increment corresponds to y in the for loop shown above.

- End corresponds to z in the for loop shown above.

Vector of Indices
Choose this option to execute a for loop of the following form:

for varname=[a b c ...]

Enter the appropriate values in the Vector field in the form a b c ...



For Loop

4-74

Workspace 
Variable

Show index value in base workspace
Use this option to place the loop index (the value of the for loop variable) 
in the workspace while other components are executing.

Variable name
Enter the variable name in this field. The variable name is varname in the 
for loop forms described above.

Remove variable from workspace when done
Use this option to remove the loop index from the workspace. This option 
is only available if you selected the Show index value in base workspace 
option.

Insert Anything 
into Report?

No.

Filename rptgen_lo.clo_for
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4Handle Graphics Linking AnchorCategory Handle Graphics

Description The Handle Graphics Linking Anchor component designates a location to 
which other links point. This component should have a looping component as 
its parent.

Attributes The following figure shows the Handle Graphics Linking Anchor properties 
panel:

Insert text
If you want text to appear after the linking anchor, enter the text in this 
field.

Link from current
This option sets the current model, system, block, or signal as the linking 
anchor:
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- Select Automatic to automatically select the appropriate figure, axes, or 
object as a linking anchor. If the Figure Loop component is the parent 
component, then the linking anchor is set on the current figure. Similarly, 
if the Object Loop is the parent component, then the linking anchor is 
inserted for the current object.

- Select Figure to set the linking anchor to the current figure.

- Select Axes to set the linking anchor to the current axes.

- Select Object to set the linking anchor to the current object.

Insert Anything 
into Report?

Yes. Anchor.

Filename rptgen_hg.chg_obj_anchor
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4Handle Graphics  NameCategory Handle Graphics

Description The Handle Graphics Name component inserts the name of a Handle Graphics 
object into the report as text.

You can use this component to create a section title based on the current figure. 
First, make sure that this component is the first child component of a 
Chapter/Subsection component, and select the Get title from first child 
component option in the Chapter/Subsection component.

Attributes The following figure shows the Handle Graphics Name properties panel:
 

Display name as
Select Figure to show the name of the current Handle Graphics figure. The 
name of the current figure comes from the first nonempty figure parameter 
in the following order:
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- Name

- Tag

- FileName

- Handle

Select Axes to show the name of the current axes. The name of the current 
axes comes from the first nonempty axes parameter in the following order:

- Title

- Xlabel

- Ylabel

- Zlabel

- Tag

- Handle

Select the Other Object option to take the name of the current object from 
the figure’s CurrentObject parameter and its first nonempty figure 
parameter in the following order:

• uicontrol

- String

- Style

- Handle

• uimenu

- Label

- Accelerator

- Tag

- Handle

• uicontextmenu, image, light, line, patch, or surface

- Tag

- Handle

• text

- String

- Tag

- Handle
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See the MATLAB graphics documentation for a discussion of the 
CurrentObject property.

Show name of current
Select one of the three options listed below Name (example: Name)

- Figure
- Axes
- Other Object

Insert Anything 
into Report?

Yes. Text.

Filename rptgen_hg.chg_obj_name
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4Handle Graphics Object LoopCategory Handle Graphics

Description The Handle Graphics Object Loop component runs its child components for 
each Handle Graphics object currently open in the MATLAB workspace. The 
component inserts a table into the generated report.

Attributes The following figure shows the Handle Graphics Object Loop properties 
panel:

Select Objects Exclude GUI objects (uicontrol, uimenu, ...}
Select this option to exclude GUI objects, such as uicontrol and uimenu, 
from the loop.

Loop list
Use this list to select the loop level for Handle Graphics objects:

- Loop on objects with handle visibility "on"
- Loop on all objects

Search for
Enter search terms in this field. Separate search terms with a space.



Handle Graphics Object Loop

4-81

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is 
selected.

Filename rptgen_hg.chg_obj_loop
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4Handle Graphics ParameterCategory Handle Graphics

Description The Handle Graphics Parameter component inserts a single 
property name/property value pair from a Handle Graphics figure, axes, or 
other object.

Attributes The following figure shows the Handle Graphics Parameter properties panel:

Property 
Selection

Get property from current
Select a Handle Graphics object to report on:

- Select Figure to insert a figure’s property name/property value pair.

- Select Axes to insert an axes’ property name/property value pair.

- Select Object to insert an object’s property name/property value pair. 

Figure property
Choose the type of property you want to include from the list in this section. 
All shows every parameter for the current object. Select the property you 
want to include in the report from the list box in this section.
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Display 
Options

Title
Choose a title for the display in the generated report. To generate a title 
automatically from the parameter, select Automatic. To enter a title, select 
Custom. To specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated report. Units 
are in pixels. When creating a table, the size limit is the hypotenuse of the 
table width and height [sqrt(w^2+h^2)]. When creating text, the size limit 
is the number of characters squared. If the size limit is exceeded, the 
variable is rendered in condensed form, such as [64x64 double]. Setting a 
size limit of zero will ignore the size limit and always display the variable, 
no matter how large.

Display as
Choose a display style from the menu:

- Auto table/paragraph — Displays as a table or paragraph based on the 
information.

- Inline text — Displays as inline, which fits in line with the surrounding 
text.

- Paragraph — Displays as a text paragraph.

- Table — Displays as a table.

Ignore if value is empty
Select this option to exclude empty parameters in the generated report.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen_hg.chg_property
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4Handle Graphics Property TableCategory Handle Graphics

Description The Handle Graphics Property Table component inserts a table that reports on 
property name/property value pairs.

See “Working with Property Table Components” on page 3-11 for a tutorial on 
the Handle Graphics Property Table component.

Attributes The following figure shows the Handle Graphics Property Table properties 
panel:

Select Graphics 
Object

Object type
Choose the object type for the generated report:

- Figure
- Axes

- Object

Filter by class
Select this option to filter the object by the specified class or classes. This 
option enables you to select a specific class for the table. For example, when 
selecting type Object, you can filter by class line. If the object is type 
surface, it does not generate a property table.
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Table A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table list in the upper left corner of the attributes 
page. To apply a preset table, select the table and click Apply.

Preset table
Choose a type of table to display the object property table:

- Defaults
- Callbacks
- Graphics
- Printing

- Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into separate 
cells. To have the property name and property value appear in adjacent 
horizontal cells in the table, select the Split property/value cells check 
box. In this case, the table is in split mode and there can be only one 
property name/property value pair in a cell. If you have more than one 
name/property pair in a cell, then only the first pair is displayed in the 
report. All subsequent pairs are ignored.

To have the property name and property value appear together in one cell, 
deselect the Split property/value cells. This is nonsplit mode. In nonsplit 
mode, you can have more than one property name/property value pair and 
you can also have text.

If you want to switch from nonsplit mode to split mode, make sure that you 
have only one property name/property value pair per table cell before you 
switch modes. If you have more than one property name/property value 
pair or any text, then only the first property name/property value pair 
appears in the report; subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the generated 
report.

Table Cells
Use this pane to select table properties to modify. The selection in this pane 
affects the available fields in the Title Properties pane.
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Title Properties The visible options in the Title Properties pane depend on the object selected 
in the Table Cells pane. If Figure Properties is selected, only the Contents 
and Show options are displayed. If any other object is selected in the Table 
Cells pane, the Alignment, Lower border, and Right border options are 
displayed.

Contents
Use this field to modify the contents of the table cell selected in the Table 
Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell in the Table 
Cells pane:

- Left
- Center
- Right

- Double justified

Show as
Choose the format for the contents of the table cell:

- Value

- Property Value

- PROPERTY Value

- Property: Value

- PROPERTY: Value

- Property - Value

- PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the generated 
report.

Right border
Select this option to display the right border of the table in the generated 
report.
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Creating Custom Tables
To create a custom table, you can first select a preset table and then edit it. You 
might want to start with the Blank 4x4 preset table. You can add and delete 
rows and you can add properties. To open the Edit Table dialog box, click the 
Edit button. The dialog box appears, as the following figure shows:

For more information about using this dialog box to create custom property 
tables, see “Working with Property Table Components” on page 3-11.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_hg.chg_prop_table
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4Handle Graphics Summary TableCategory Handle Graphics

Description The Handle Graphics Summary Table component inserts a table that 
summarizes Handle Graphics object properties. Each row in the table 
represents an object, and each column in the table represents a property. You 
can specify the object properties to be included in the report.

Attributes The following figure shows the Handle Graphics Summary Table properties 
panel:

Object type
Choose the object type to display in the generated report:

- figure
- axes
- object
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The available options in the Select Objects pane depend on your selection 
in the Object type menu. 

Table title
Choose a title for the summary table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Property 
Columns

Property columns
This figure displays the object properties to be included in the summary 
table in the generated report. To add a property, select the appropriate 
property level in the menu. Next, in the contextual list below the menu, 
select the property that you want to add and click the Add button . To 
delete a property, select the property name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary table in 
the generated report. Entered widths should be in percentages.

Object Rows Insert anchor for each row
Select this option to insert an anchor for each row in the summary table.

Object 
Selection

The options displayed in the Object Selection pane depend on the object type 
selected in the Object type list. If figure is selected in Object type, the 
following options are displayed:

Include figures
To include only the current figure in the report, select the Current figure 
only option. 

To loop on all visible figures, select the Visible figures option. This 
option executes child components for all figures that are currently open and 
visible. The Data figures only option is checked by default and excludes 
figures with HandleVisibility = 'off' from the loop.

To loop on figures with certain tags, select the All figures with tags 
option. When you are selecting a tag, all figures with that tag are included, 
regardless of whether the figure is visible or whether HandleVisibility is 



Handle Graphics Summary Table

4-90

'on' or 'off'. The tag list box (located under the All figures with tags 
option) shows the selected tags. To add a tag to the tag list box, type in the 
tag.

Loop Figure List
The Loop Figure List shows you the figures that would be looped on given 
the current set of figures.

If axes is selected in Object type, the following options are displayed:

Loop type
To loop on all axes objects, select All axes. To loop on the selected axes 
object, select Current axes. 

Exclude objects which subclass axes
Select this option to exclude objects such as legends and color bars.

Loop Menu
To loop only on visible axes objects, select Loop on axes with handle 
visibility "on". To loop on all axes objects, select Loop on all axes.

Search terms
Enter search terms for the loop. For example, to search for Tag and My 
Data, enter "Tag", "My Data".

If object is selected in Object type, the following options are displayed:

Exclude GUI objects (uicontrol, uimenu, ...}
Select this option to exclude GUI objects, such as uicontrol and uimenu, 
from the loop.

Loop menu
Use this menu to select the loop level for Handle Graphics objects:

- Loop on objects with handle visibility "on"
- Loop on all objects

Search for
Enter search terms in this field. Separate search terms with a space.

Insert Anything 
into Report?

Yes. Table.
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Filename rptgen_hg.chg_summ_table
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4ImageCategory Formatting

Description The Image component inserts an image from an external file into the report. 
The Image component can have the Chapter/Subsection or Paragraph 
component as its parent. If the Paragraph component is its parent, then the 
Insert as inline image check box must be checked.

Attributes The following figure shows the Image properties panel:

File Name File name
Enter the image filename in this field or use the browse button (...) to find 
the file that contains the image. 

Make sure that the image is in a format that your viewer can read. Your 
viewer depends on the report format you selected in the Report Options 
page in the Report Explorer. For a discussion on report format options, see 
Chapter 2, “Setting Report Output Options.”
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You can use the %<VariableName> notation. See “%<VariableName> 
Notation” in the Text component reference.

Copy to local report files directory
Select this option to save a copy of the image to a local report files directory.

Display 
Options

Image Title
Choose a title option in this section:

- No title: Select this option if you do not want an image title.

- Title: Select this option and type the image title in the corresponding field 
if you want an image title that is not the same as the image file name.

- Title from filename: Select this option if you want the image title to be 
the same as the image filename.

Insert as inline image
Select this option if you want to insert an inline image in a paragraph. This 
option is available only when the image does not have a title, i.e., if you 
select the No title option in the Image Title option. To make this a valid 
option, the Image component must have the Paragraph component as its 
parent and Text components as its peers.

For example, if the following components are included in a setup file,

paragraph
text - This is an example of an inline image.
text - This is an example.
image - *image.jpg*
text - This is an example of an inline image.

and you select the Insert as inline image option, the report would contain 
the following paragraph:

This is an example of an inline image. This
is an example. *image.jpg* This is 
an example of an inline image.

If you do not select the Insert as inline image option, then the report 
would contain the following paragraph (notice that the image is not inline).

This is an example of an inline image. This
is an example.
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*image.jpg*
This is an example of an inline image.

Caption
Enter a short text description for the image.

Preview The Preview pane shows the image that you specify in the Image file name 
field. You cannot preview PostScript images or images with formats that are 
not supported by the imread function, such as .gif.

If you click the image in the Preview pane, it is displayed in full size on the 
screen.

Insert Anything 
into Report?

Yes. Image.

Filename rptgen.cfr_image
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4Import FileCategory Report Generator

Description The Import File component imports an ASCII text file.

Attributes The following figure shows the Import File properties panel:

File name
Enter the name of the file to import in the text field in this section or use 
the browse button (...) to find the file. This component executes only if you 
enter a valid filename in this field.

Import file as

• Plain text (ignore line breaks): Select this option to import the file as 
plain text without any line breaks (no paragraphs). If you select this option, 
the Import File component acts like the Text component and should have the 
Paragraph component as its parent.

In this example and subsequent examples, the following text is used as the 
input file.
This is the first row of text from the imported file.
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The second row follows a line break in the first row.

There is a blank line above the third row.

With the Plain text (ignore line breaks) option, the following is 
produced.
This is the first row of text from the imported file. 
The second row follows a line break in the first row. 

There is a blank line above the third row.

• Paragraphs defined by line breaks: Select this option to import the file 
as text contained in paragraphs defined by line breaks (hard returns or 
carriage returns).

With the Paragraphs defined by line breaks option, the following is 
produced.
This is the first row of text from the imported file.
The second row follows a line break in the first row.

There is a blank line above the third row.

• Paragraphs defined by empty rows: Select this option to import the file as 
text contained in paragraphs defined by empty rows (rows that do not 
contain text).

With the Paragraphs defined by empty rows option, the following is 
produced.
This is the first row of text from the imported file. 
The second row follows a line break in the first row.

There is a blank line above the third row.

• Text (retain line breaks): Select this option to import the file as plain 
text, including line breaks.

With the Text (retain line breaks) option, the following is produced.
This is the first row of text from the imported file.
      The second row follows a line break in the first row.

There is a blank line above the third row.
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• Fixed-width text (retain line breaks): Select this option to import the 
file as fixed-width text (all letters have the same width or size) including line 
breaks. This option is best suited for importing M-files.

With the Fixed-width text (retain line breaks) option, the following is 
produced.
This is the first row of text from the imported file.
      The second row follows a line break in the first row.

There is a blank line above the third row.

• DocBook XML: Select this option if the inserted text file is in an XML source 
file. The format of the inserted XML file is not changed.

• Formatted Text (RTF/HTML): Select this option if the inserted text file is in 
an RTF or HTML source file. The format of the inserted RTF or HTML source 
file is not changed.

• Syntax highlighted M-code: Select this option if the inserted text file is an 
M-file containing highlighted M-code.

File Contents
This field displays the first few lines of the file to be imported.

Insert Anything 
into Report?

Yes. Inserts text if you select one of the following options:

• Plain text (ignore line breaks)
• Text (retain line breaks)
• Fixed-width text (retain line breaks)

Inserts paragraphs if you select one of the following options:

• Paragraphs defined by line breaks
• Paragraphs defined by empty rows

Inserts the contents of the XML file if you select the DocBook XML option. This 
can include text, paragraphs, tables, etc.

Inserts the contents of the RTF or HTML file if you select the Formatted text 
(RTF/HTML) option. This can include text, paragraphs, tables, etc.

Filename rptgen.crg_import_file
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4Insert VariableCategory MATLAB

Description The Insert Variable component takes one of the following variables and inserts 
its value (and name, if you choose to do so) into the report:

• A variable from the MATLAB workspace

• A variable from a MAT-file

• A global variable

Attributes The following figure shows the Insert Variable properties panel:

Source Variable name
Enter the name of the variable in this field.

You can use %<VariableName> to insert the value of a variable from the 
MATLAB workspace. For example, if you enter the following expression in 
this field,

%<my_variable>
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and you have the following in your MATLAB workspace:

my_variable='velocity'
velocity=50

then your report will contain the following:

50

If you enter %<velocity> in this field, and your MATLAB workspace 
contains the same information, then your report will also contain 50.

Variable location
Select one of the following options:

•Base Workspace — This option gets a variable from the MATLAB 
workspace.

•MAT File — This option gets a variable from a binary file with a .mat 
extension.

•Global variable — This option gets a global variable.

Display 
Options

Title
Choose a title for the display in the generated report. To generate a title 
automatically from the parameter, select Automatic. To enter a title, select 
Custom. To specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated report. Units 
are in pixels. When creating a table, the size limit is the hypotenuse of the 
table width and height [sqrt(w^2+h^2)]. When creating text, the size limit 
is the number of characters squared. If the size limit is exceeded, the 
variable renders in condensed form, such as [64x64 double]. Setting a size 
limit of zero will ignore the size limit and always display the variable, no 
matter how large.

Display as
Choose a display style from the menu:

- Auto table/paragraph — Displays as a table or paragraph based on the 
information.
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- Inline text — Displays as inline, which fits in line with the surrunding 
text.

- Paragraph — Displays as a text paragraph.

- Table — Displays as a table.

Ignore if value is empty
Select this option to exclude empty parameters in the generated report.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen.cml_variable



Link

4-101

4LinkCategory Formatting

Description The Link component inserts linking anchors or pointers into the report.

Attributes The following figure shows the Link properties panel:

Link type
Select the type of link to insert into the report:

- Linking Anchor: An anchor is the object to which something links; i.e., 
links “link” to an anchor.

- Internal Document Link: A link takes you to the location in your report 
(specified by an anchor) to which it points when you click it.

- URL (external) Link: A URL link is a link to a Web site. It takes you to 
the location on the Web to which your link points when you click it.

Link identifier
The link identifier options are context sensitive and change depending on 
the link type selected above. The Link identifier field marks the location 
to which the link points. The link is not visible in the report.

Link text
Enter text to use in the link.
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Emphasize link text
Select this option to italicize the link text.

Insert Anything 
into Report?

Yes. Text or anchor.

Filename rptgen.cfr_link
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4ListCategory Formatting

Description The List component creates a bulleted or numbered list from a cell array or 
from child components.

Attributes The following figure shows the List properties panel:

List Content Create list from workspace cell array
Enter the name of the 1-by-n or n-by-1 cell array from which the list will be 
created in this field. This option is not available when this component has 
child components, because the list is then automatically generated from 
the child components.

List title
Enter the title of the list in this field.

List Formatting List style
Select either Bulleted list or Numbered list. If you choose Numbered 
list, then you can select numbering options in the Numbering style 
field.
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Numbering style
Select a numbering style in this pull-down menu if you selected Numbered 
List for the List style. The options are

- 1,2,3,4,...

- a,b,c,d,...

- A,B,C,D,...

- i,ii,iii,iv,...

- I,II,III,IV,... 

Show parent number in nested list (1.1.a)
Select this option to show all level numbers in a nested list. You can create 
a nested list by putting one cell array inside another or by nesting one List 
component inside another. If you choose this option, your list will have this 
type of appearance (the actual appearance depends on the option chosen in 
the Numbering style field).

1. Example
2. Example

2.1. Example
2.2. Example

2.2.a. Example
2.2.b. Example

3. Example

Note that this option is not available if you select the Show only current 
list value (a) option.

Show only current list value (a)
Select this option to show only the current list value. If you choose this 
option, the list shown above will have this type of appearance (the actual 
appearance depends on the option chosen in the Numbering style field).

1. Example
2. Example

1. Example
2. Example

1. Example
2. Example

3. Example
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Note that this option is not available if you select the Show parent number in 
nested list (1.1.a) option.

Continue numbering from previous list
Select this option to continue list numbering from a previous list. Note that 
this option is not available if you select the Always start at 1 option.

Always start at 1
Select this option to always start list numbering at 1. Note that this option 
is not available if you select the Continue numbering from previous list 
option.

Example1: Creating a Nested List
You can create a nested list by putting one cell array inside another or by 
nesting one List component inside another.

For example, if you have the following setup file, with one List component 
nested inside another List component,

[-] Report - Unnamed.rpt
   [-] Bulleted list from child components
      [ ] Text - sky
      [ ] Table - varname
      [ ] Image - test.jpg
      [ ] Text - grass
      [-] Bulleted list from child components
         [ ] Text - clouds
         [ ] Text - sun
      [-] Paragraph - information

then the report would contain the following bulleted lists:

• sky

• Table from variable - varname

• Snapshot of image - test.jpg
• grass

- clouds
- sun

• information
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Example 2: Creating the Same List with Child Components and a Cell 
Array
Setup file with child components:

[-] Report - Unnamed.rpt
   [-] Bulleted list from child components
      [ ] Text - red
      [ ] Text - green
      [ ] Text - blue

Setup file calling a cell array:

[-] Report - Unnamed.rpt
   [-] Bulleted list from cell array called colors

Cell array:

colors={'red','green','blue'}

Using either of these two setup files, the report contains the following bulleted 
list:

• red

• green

• blue

Insert Anything 
into Report?

Yes. List.

Filename rptgen.cfr_list
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4Logical ElseCategory Logical and Flow

Description The Logical Else component acts as an else when it is the child of the Logical 
If component. There are two ways to use this component:

if
then
else

or

if
then
elseif
elseif
   .
   .
   .
else

Attributes The following figure shows the Logical Else properties panel:
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If component has no children, insert text
When the Logical Else component has no child components, the string in 
this field is inserted into your report. In this case, this component acts like 
the Text component.

Insert Anything 
into Report?

Depends on whether if or elseif statement is true.

Filename rptgen_lo.clo_else
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4Logical ElseifCategory Logical and Flow

Description The Logical Elseif component acts as an elseif when it is the child of the 
Logical If component. You must use this component in this format:

if
then
elseif
elseif
   .
   .
   .
else

Attributes The following figure shows the Logical Elseif properties panel:

Test expression
Enter a MATLAB expression to evaluate.
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If component has no children, insert text
When the Logical Elseif component has no child components, the string in 
this field is inserted into the report. In this case, this component acts like 
the Text component.

Insert Anything 
into Report?

Yes, only when parent if statement is false.

Filename rptgen_lo.clo_else_if
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4Logical IfCategory Logical and Flow

Description The Logical If component acts as a logical if; it can have the Logical Then, 
Logical Elseif, and Logical Else components as its child components. This 
component executes its child components when the given workspace expression 
is true. It displays a specified string when it has no child components. There 
are three ways to use this component:

if
then

or

if
then
else

or

if
then
elseif
elseif
   .
   .
   .
else
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Attributes The following figure shows the Logical If properties panel:

Test expression
Enter a MATLAB expression to evaluate.

If component has no children, insert text
When the Logical If component has no child components, the string in this 
field is inserted into your report.

Insert Anything 
into Report?

Depends on attributes.

Filename rptgen_lo.clo_if
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4Logical ThenCategory Logical and Flow

Description The Logical Then component acts as a then when it is the child of the Logical 
If component. There are three ways to use this component:

if
then

or

if
then
else

or

if
then
elseif
elseif
   .
   .
   .
else
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Attributes The following figure shows the Logical Then properties panel:

If component has no children, insert text
When the Logical Then component has no child components, the string in 
this field is inserted into your report. In this case, this component acts like 
the Text component.

Insert Anything 
into Report?

Yes, only when parent if statement is true.

Filename rptgen_lo.clo_then
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4Look-Up TableCategory Simulink Blocks

Description The Look-Up Table component reports on the following lookup table blocks: 
Look-Up Table, Look-Up Table (2-D), Look-Up Table (n-D), and Prelook-Up 
Index Search.

This component inserts a figure and/or table into the report; the table contains 
input and output numeric values, and the figure is a plot of the values.

Attributes The following figure shows the Look-Up Table properties panel:

Look-Up Table 
Options

This pane allows you to specify the types of Look-Up Table blocks that are 
included in the report and how they are displayed. If none of the check 
boxes in this pane are selected, the component does not insert anything 
into the report.

These options display the lookup tables, depending on what the component 
is operating on:

- If the Look-Up Table has the Model Loop as its parent, it includes all 
lookup tables in the current model.
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- If the Look-Up Table has the System Loop as its parent, it includes all 
lookup tables in the current system.

- If the Look-Up Table has the Block Loop as its parent, it includes the 
current block if it is a look-up table.

- If the Look-Up Table has the Signal Loop as its parent, it includes all 
lookup tables connected to the current signal.

- If the Look-Up Table does not have any of the Simulink looping 
components as its parent, it includes all lookup tables in all open models.

Plot 1-D data
Select this option to plot data from a Look-Up Table block and choose the 
plot type (Line plot or Bar plot) from the corresponding list. See the 
MATLAB graphics documentation for more information on line plots and 
bar plots. The input data is shown on the horizontal or x-axis and the 
output data is shown on the vertical or y-axis.

Create table for 1-D data
Select this option to create a table that contains numeric data values from 
the Look-Up Table block.

Plot 2-D data
Select this check box to include a plot of 2-D Look-Up Table blocks. You can 
specify whether the data appears as a surface plot or a line plot. The line 
plot is best for small data sets and the surface plot is most appropriate for 
larger tables. See the MATLAB graphics documentation for more 
information on surface plots and line plots. 

Create table for 2-D data
Select this option to create a table that contains numeric data values from 
the Look-Up Table (2-D) block.

Create table for N-D data
Select this option to create a table that contains numeric data values from 
the Look-Up Table (n-D) block. Note that this is a 2-D slice through the N-D 
data.

Print Options Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic HG Format to automatically choose the format best suited for 
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the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic HG 
Format is the default option. The options include

- Automatic SL Format (Uses the Simulink file format selected in the 
Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
- Bitmap (256-color)
- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed
- Windows metafile
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Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use figure orientation option. See the orient 
command for information about paper orientation.

Image size
Select Use figure PaperPositionMode setting to use the 
PaperPositionMode property of the Handle Graphics figure to set the 
image size in the report. See the orient command for information about 
paper position mode.

Select the Automatic (same size as on screen) option if you want the 
image in your report to be the same size as the image on the screen.

Select the Custom option to choose a custom image size. If you choose this 
option, specify the image size in the Size field and Units list.

- Size: Enter the size of the Handle Graphics figure snapshot in the form 
wxh (width times height). This field is active only if you choose Custom in 
the Image size list box.

- Units: Enter the units for the size of the Handle Graphics figure snapshot. 
This field is active only if you choose Custom in the Image size list box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This 
parameter inverts colors for printing; i.e., it changes dark colors to light 
colors and vice versa. 

Select one of the following options:

- Automatic — Select this option to automatically change dark axes colors 
to a light axes color. If the axes color is a light color, then it is not inverted.

- Invert — Select this option to change dark axes colors to light axes colors 
and vice versa. 

- Don't invert — Select this option if you do not want to change the colors 
in the image displayed on the screen for printing.

- Use figure's InvertHardcopy setting — Select this option to use the 
InvertHardcopy property set in the Handle Graphics image.

- Make figure background transparent — Select this option to make the 
image background transparent.
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Annotation Title
Enter a title for the snapshot figure.

Caption
Enter a short text description for the snapshot figure.

Insert Anything 
into Report?

Yes. Figure and/or table.

Filename rptgen_sl.csl_blk_lookup
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4Machine LoopCategory Stateflow

Description The Machine Loop component runs its child components for all selected 
Stateflow machines. The Machine Loop component is context sensitive of its 
parent component. If no parent, the Machine Loop runs its child components 
for all machines. If a model is its parent, it runs its child components for all 
machines in the model. 

Attributes The following figure shows the Machine Loop properties panel:

Loop Options Search States
Select this option to search states that you specify in the field that appears 
below the check box. 

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.
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Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, section, if the Create Section for each object in loop option is selected.

Filename rptgen_sf.csf_machine_loop
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4MATLAB Property TableCategory MATLAB

Description The MATLAB Property Table inserts a table that reports on MATLAB object 
property name/property value pairs.

Attributes The following figure shows the MATLAB Property Table properties panel:

Table A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table list in the upper left corner of the attributes 
page. To apply a preset table, select the table and click Apply.

Preset table
Choose a type of table to display the object property table:

- Defaults

- Callbacks

- Graphics

- Printing

- Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into separate 
cells. To have the property name and property value appear in adjacent  
cells, select the Split property/value cells check box. In this case, the table 
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is in split mode and there can be only one property name/property value 
pair in a cell. If you have more than one name/property pair in a cell, then 
only the first pair is displayed in the report. All subsequent pairs are 
ignored.

To have the property name and property value appear together in one cell, 
deselect the Split property/value cells. This is nonsplit mode. In nonsplit 
mode, you can have more than one property name/property value pair and 
you can also have text.

If you want to switch from nonsplit mode to split mode, make sure that you 
have only one property name/property value pair per table cell before you 
switch modes.

Display outer border
Select this option to display the outer border of the table in the generated 
report.

Table Cells
Use this field to select table properties to modify. The selection in this pane 
affects the available fields in the Cell Properties pane.

Title Properties The visible options in the Title Properties pane depend on the object selected 
in the Table Cells pane. If Workspace Properties is selected, only the 
Contents and Show options are displayed. If any other object is selected in the 
Table Cells pane, the Alignment, Lower border, and Right border options 
are displayed.

Contents
Use this field to modify the contents of the table cell selected in the Table 
Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell in the Table 
Cells field:

- Left
- Center
- Right
- Double justified
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Show as
Choose the format for the contents of the table cell:

- Value

- Property Value

- PROPERTY Value

- Property: Value

- PROPERTY: Value

- Property - Value

- PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the generated 
report.

Right border
Select this option to display the right border of the table in the generated 
report.

Creating Custom Tables
To create a custom table, you can first select a preset table and then edit it. You  
might want to start with the Blank 4x4 preset table. You can add and delete 
rows and you can add properties. To open the Edit Table dialog box, click the 
Edit button. The dialog box appears:
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For more information about using this dialog box to create custom property 
tables, see “Working with Property Table Components” on page 3-11.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen.cml_prop_table
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4MATLAB/Toolbox Version NumberCategory MATLAB

Description The MATLAB/Toolbox Version Number component creates and inserts a table 
that shows the version number, release number, and/or release date of any 
MathWorks software you are currently using. You can get a list of all your 
toolboxes by typing ver at the command line.

Attributes The following figure shows the MATLAB/Toolbox Version Number properties 
panel:

Table Title Table title
Enter the title of the table in this field.

Table Columns Version number
Select this option to include the version number of any MathWorks 
software you are currently using.
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Release number
Select this option to include the release number of any MathWorks 
software you are currently using.

Release date
Select this option to include the release date of any MathWorks software 
you are currently using.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen.cml_ver
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4Model Change LogCategory Simulink

Description The Model Change Log component uses a reported model’s ModifiedHistory 
parameter to construct a model history table that displays information about 
each logged revision to the model. This model history table can contain 
information about any of the following:

• Author of each change

• Model version of the change

• Time and date of the change

• Description of the change

To see the model revision history parameters, select Model Properties from 
the model’s File menu, which displays the Block Diagram Properties dialog 
box. The Model Properties tab in this dialog box contains the model revision 
history parameters.

The Options tab in the Block Diagram Properties dialog box controls how the 
version number is incremented. The History tab controls history updates and 
lets you edit the ModifiedHistory string. You must select the Prompt For 
Comments When Save option from the Modified History Update list in order to 
save your revisions. This component does not run if the model’s 
ModifiedHistory parameter is empty or if you edit the parameter in such a 
way that the Report Generator cannot parse it; in these cases, the Comment 
component cannnot produce the table.

For more information on the Block Diagram Properties dialog box and model 
history, see the Simulink documentation.

Note that if your model has a long revision history, you might want to limit the 
number of revisions reported.

The Model Change Log component should run before the Model Simulation 
component.

Attributes The following figure shows the Model Change Log properties panel:
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Table Columns You can choose the information displayed in the model revision table in this 
section.

Author name
Select this option if you want to include the name of the person responsible 
for the revision of the model.

Version
Select this option if you want to include the version number of the model.

Date changed
Select this option if you want to include the date on which the model was 
revised.

Description of change
Select this option if you want to include a description of the revision to the 
model.
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Table Rows Limit displayed revisions to
Select this option to limit the number of revisions that is displayed in the 
report. Enter the number in the corresponding text field.

Show revisions since date
Select this option to limit the number of revisions that is displayed in the 
report by date. Enter the date in the corresponding text field. The 
%<varname> notation is legal. For example, %<datestr(now-14)> returns 
the revisions for the last two weeks.

Table Display You can choose how the model revision history table is displayed in this section.

Table title
Enter the title of the table in this field.

Example
This is an example of a report generated from a setup file with the Model 
Change Log component.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sl.csl_mdl_changelog
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4Model LoopCategory Simulink

Description The Model Loop component runs its child components for all selected Simulink 
models and systems. The Model Loop component can run its child components 
for a specific model, such as the demo model F14, or it can run its child 
components for all models or the current model.

Because Simulink components are context sensitive, they should be children of 
the Model Loop (although the Model Loop does not have to be the immediate 
parent of some Simulink components). 

Attributes The following figure shows the Model Loop attribute panel:

Models to Include
The Models to Include field contains a list of reported models. To add 
another model to the list, click the Add New Model to List button. The 
following table shows the button you should use to move a model up or 
down in the list, or to add or delete a model.
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Model Options Active
Select this option to include the active model. If not selected, the model will 
be omitted. This option provides a way of temporarily deactivating a model.

Model name
Choose a model name:

- Enter the model name. The &<varname> notation is allowed.

- Current model

- All models

The selection in the Model name option affects the available options for the 
Traverse model option. 

Traverse model
Choose system to traverse:

- All systems in model

- Selected system(s) only

Button Action

Move a model up in the list.

Move a model down in the list.

Remove a model from the list.

Add a model to the list.
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- Selected system(s) and ancestors

- Selected system(s) and children 

The options available in the Traverse model list are affected by the 
selection in the Model name list.

Starting system(s)
Select the system in which to start the loop. The available options in the 
Starting system(s) list are affected by the selection in the Traverse model 
list. For example, if All systems in model is selected in the Traverse 
model list, the Starting system(s) list is not relevant.

Look under masks
Simulink systems can have masks. The masks can be functional or 
graphical. Choose how to handle masks: 

- No masks
- All masks
- Functional masks only
- Graphical masks only

See the Simulink documentation for more information about masks.

Follow library links
Simulink blocks and systems can be linked to a library. Choose the library 
links to include:

- Do not follow library links
- Include library links
- Include unique library links

See the Simulink documentation for more information about library links.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.
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Insert Anything 
into Report?

Yes, if the Create section for each object in loop option is selected.

Filename rptgen_sl.csl_mdl_loop
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4Model SimulationCategory Simulink

Description The Model Simulation component runs the current model using the simulation 
parameters specified in the attributes page. This component should have the 
Model Loop component as its parent.

Attributes The following figure shows the Model Simulation properties panel: 

I/O 
Parameters

Use model's workspace I/O variable names
Select this option to use the names of the variables specified in the 
Simulation Parameters dialog box. For a description of these variables, 
see the Simulink documentation.

The following options are available if you do not select the Use model's 
workspace I/O variable names option:

- Time — Enter a new variable name for the Time parameter in this field. 
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- States — Enter a new variable name for the States parameter in this 
field.

- Output — Enter a new variable name for the Output parameter in this 
field.

Timespan Use model’s timespan values
Select this option to use the model’s Start time and Stop time values 
specified in the Solver tab in the Simulation Parameters dialog box. For 
a description of these variables, see the Simulink documentation.

The following options are available if you do not select the Use model's 
timespan values option:

- Start — Enter a new simulation starting time in this field.

- Stop — Enter a new simulation ending time in this field.

Note  If your model’s stop time is set to inf (infinity) in Simulink or on this 
component’s attribute page, then the Report Generator terminates the model 
simulation after 60 seconds to prevent the report from generating for an 
infinite amount of time.

Insert Anything 
into Report?

No.

Filename rptgen_sl.csl_mdl_sim



Nest Setup File

4-137

4Nest Setup FileCategory Report Generator

Description The Nest Setup File component runs another setup file at the point where the 
Nest Setup File component is listed in the current setup file. The Nest Setup 
File component allows one setup file (.rpt) to run inside another. 

The components of the inserted setup file enter the current setup file at the 
level of the Nest Setup File component. Thus, the inserted components have 
the same parent component as the Nest Setup File component. Make sure that 
the inserted components can have this parent component.

Attributes The following figure shows the Nest Setup File properties panel:

Setup file to run
Enter the name of the setup file to import and run in this field or use the 
browse button (...) to find the file. This component executes only if you enter 
a valid filename in this field.
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Inline nested report in this report
Select this option to insert the nested report at the place in the original 
report where this component is located.

Insert link to external report
Select this option to create two separate reports, one with the original 
setup file and one with the nested setup file. 

Recursion limit
If you want to nest a setup file inside itself, you can set a recursion limit in 
this field. The recursion limit sets a limit on the number of times the setup 
file can run itself.

Nest all reports with specified file name
Select this option to nest all reports with the same name as specified in the 
Setup file to run option.

Example
In the example shown below, the setup file R2.rpt is nested in R1.rpt.

[-] Report - R1.rpt                [-] Report - R2.rpt
 [ ] Chapter                              [ ] 1
      [-] B                               [ ] 2
         [ ] Nest Setfile - R2.rpt       [-] Chapter
         [ ] C                              [ ] 4
      [ ] D                                 [ ] 5

The report executes as if the original setup file looked like this.

    [-] Report - R1.rpt
      [ ] Chapter
      [-] B
         [ ] 1
         [ ] 2
         [-] Section 1
           [ ] 4
           [ ] 5
         [ ] C
      [ ] D
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Components that determine their behavior from their parents, such as 
Chapter/Subsection, are affected by components in the parent setup file (as 
shown above). See the Chapter/Subsection reference page for more details on 
the Chapter/Subsection component.

Insert Anything 
into Report?

Yes, if the nested setup file produces visible output.

Filename rptgen.crg_nest_set
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4ParagraphCategory Formatting

Description The Paragraph component inserts a paragraph into the report. The paragraph 
text is taken from a child text component or from text that you enter in the 
Paragraph Text field.

Attributes The following figure shows the Paragraph properties panel:

Title Options No paragraph title
Select this option if you do not want the paragraph to have a title.

Get title from first child component
Select this option if you want the title of the paragraph to be taken from the 
first child component. The first child component should be a Text 
component.

Specify title
Select this option and enter the title of the paragraph in this field if you do 
not want the title to come from the first child component.
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Paragraph Text
Enter paragraph text in this field. If the Paragraph component has child 
components, then the paragraph content is taken from the child 
components. Otherwise, the Paragraph component inserts text from this 
field.

If the Paragraph component does not have any child components and you 
do not enter any text in this field, then the Paragraph component does not 
insert anything into the report.

Note that you can use the %<VariableName> notation in this field if you 
want to insert the value of a variable from the MATLAB workspace. See 
“%<VariableName> Notation” in the Text component reference page

Insert Anything 
into Report?

Yes. Can be text, an image, etc.; depends on child components.

Filename rptgen.cfr_paragraph
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4Requirements TableCategory Requirements Management Interface

Description The Requirements Table component creates a table that contains information 
from the Requirements Management Interface. Objects can have multiple 
requirements. Each requirement is a row in the table.

Attributes The following figure shows the Requirements Table properties panel:

Table Options Show requirements for current
Select the object type to display.

- Simulink object

- Stateflow object

Table title
Select a title for the table.

- No title
- Object name

- Custom
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Table Columns Description
Select this option to include the requirement’s description in the table.

Document name
Select this option to include the requirement’s document name in the table.

Locations within document
Select this option to include the requirement’s locations within the 
document in the table.

Requirement keyword
Select this option to include the requirement’s requirement keyword in the 
table.

Insert Anything 
into Report?

Yes. Table.

Filename RptgenRMI.CReqTable
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4Scope SnapshotCategory Simulink Blocks

Description The Scope Snapshot component inserts images of Simulink scopes and XY 
graphs. If the model has not been simulated, scopes are empty. For more 
information, see “Model Simulation” on page 4-135.

Like other components, the Scope Snapshot component must conform to the 
Report Generator component hierarchy. When building setup files with the 
Scope Snapshot component, keep the following points in mind:

• If the Scope Snapshot has the Model Loop as its parent or if it does not have 
any Simulink looping component as its parent, it includes all XY graphs and 
scopes in the current model.

• If the Scope Snapshot has the System Loop as its parent, it includes all XY 
graphs and scopes in the current system.

• If the Scope Snapshot has the Block Loop as its parent, it includes the 
current block if it is an XY graph or scope.

• If the Scope Snapshot has the Signal Loop as its parent, it includes all XY 
graphs and scopes connected to the current signal.

• If the Scope Snapshot does not have any of the Simulink looping components 
as its parent, it includes all XY graphs and scopes in all open models.

Attributes The following figure shows the Scope Snapshot properties panel:
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Scope Options Report on closed scopes
Select this option to take a snapshot of all scopes in context. This option 
forces closed scopes to open when the report is generating.

Autoscale time axis
Select this option to scale the Simulink scope’s time axis to include the 
entire log.

Print Options Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic HG Format to automatically choose the format best suited for 
the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic HG 
Format is the default option. The options include

- Automatic HG Format (Uses the Simulink file format selected in the 
Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
- Bitmap (256-color)
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- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed
- Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use figure orientation option. See the orient 
command for information about paper orientation.

Image size
Enter the size of the Handle Graphics figure snapshot in the form [w h] 
(width/height). In the units text box, select Inches, Centimeters, Points, 
or Normalized. 

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This 
parameter inverts colors for printing; i.e., it changes dark colors to light 
colors and vice versa. 

Select one of the following options:
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- Automatic — Select this option to automatically change dark axes colors 
to a light axes color. If the axes color is a light color, then it is not inverted.

- Invert — Select this option to change dark axes colors to light axes colors 
and vice versa. 

- Don't invert — Select this option if you do not want to change the colors 
in the image displayed on the screen for printing.

- Use figure's InvertHardcopy setting — Select this option to use the 
InvertHardcopy property set in the Handle Graphics image.

- Make figure background transparent — Select this option to make the 
image background transparent.

Annotation Title
Select or enter a title for the snapshot figure.

- Block name — Use the block name as the title.

- Full Simulink path name — Use the Simulink pathname as the title.

- Custom — Enter a custom title.

Caption
Select or enter a short text description for the snapshot figure.

- No caption

- Automatic (use block description) — Use the Simulink block’s 
description as the caption.

- Custom — Enter a short text description for the snapshot figure.

Insert Anything 
into Report?

Yes. Image.

Filename rptgen_sl.csl_blk_scope
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4Signal LoopCategory Simulink

Description The Signal Loop component runs its child components for each signal contained 
in the current system, model, or block.

Attributes The following figure shows the Signal Loop properties panel:

Select Signals Include block input signals
Select this option to loop on signals that feed into blocks. This option is 
valid when the Signal Loop component has a Block Loop component as its 
parent.

Include block output signals
Select this option to loop on signals that leave the block. This option is valid 
when the Signal Loop component has a Block Loop component as its 
parent.
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Include system input signals
Select this option to loop on signals coming from inports. This option is 
valid when the Signal Loop component has a System Loop component as its 
parent.

Include system internal signals
Select this option to loop on system internal signals. This option is valid 
when the Signal Loop component has a System Loop component as its 
parent.

Include system output signals
Select this option to loop on signals going to outports. This option is valid 
when the Signal Loop component has a System Loop component as its 
parent.

Sort signals
Use this section to select how the signals are sorted:

- Select Alphabetically by signal name to sort signals alphabetically by 
name.

- Select Alphabetically by signal name (exclude empty) to sort signals 
alphabetically by name as long as the signals have names.

- Select Alphabetically by system name to sort by parent systems. In this 
option, the systems are sorted alphabetically, and signals in each system 
are listed, but in no particular order.

- Select By signal depth to sort signals by their depth in the model.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.
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When using the Signal Loop component, keep the following points in mind:

• If the Signal Loop has the Model Loop as its parent, it loops on all signals in 
the current model.

• If the Signal loop has the System Loop as its parent, it loops on all signals in 
the current system. You can choose not to report on the following types of 
signals by deselecting the corresponding option:

- System input signals
- System output signals

- System internal signals 

• If the Signal Loop has another Signal Loop as a parent, it loops on the 
current signal.

• If the Signal Loop has the Block Loop as a parent, it loops on all signals 
connected to the current block. You can choose not to report on the following 
types of signals by deselecting the corresponding option:

- Block input signals

- Block output signals

• If the Signal Loop does not have  the Model Loop, System Loop, Signal Loop, 
or Block Loop as its parent, it loops on all signals in all models. You can 
choose not to report on the following types of signals by deselecting the 
corresponding option:

- Block input signals
- Block output signals
- System input signals
- System output signals

- System internal signals 

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is selected.

Filename rptgen_sl.csl_sig_loop
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4Simulink Automatic TableCategory Simulink

Description The Simulink Automatic Table component inserts a two-column table that 
contains details for the selected model, system, signal, or block into a generated 
report.

Attributes The following figure shows the Simulink Automatic Table properties panel:

Options Show current
Choose the Simulink feature to include in the generated report:

- Automatic — Uses context of parent loop.
- Model
- System
- Block

- Signal

Properties list
Choose whether to select the properties manually or automatically:
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- Determine properties automatically — Uses blocks and dialog 
properties.

- Show properties  — Enter properties manually.

Show full path name
Select this option to show the full file pathname for the selected Simulink 
model.

Display property names as prompts
Select this option to show property names as prompts in the generated 
report. The report includes the dialog string instead of the underlying code 
property.

Display 
Options

Table title
Choose a title for the display in the generated report. To generate a title 
automatically from the parameter, select Name, which uses the object name 
as the title. To enter a title, select Custom. To specify no title, select No 
title.

Header row
Use this option to select a header row for the table in the generated report. 
To include no header row, select No header. To include a header row with 
columns for name and object type, select Type and Name. When selected, 
this option creates a header row for the table with object name and type. To 
include a custom header, select Custom.

Don’t display if value is empty
Select this option to exclude empty parameters in the generated report.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sl.csl_auto_table
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4Simulink Functions and VariablesCategory Simulink

Description The Simulink Functions and Variables component creates a table that shows 
all workspace variables and MATLAB functions used by reported blocks in a 
Simulink model. The current model and systems in which the blocks appear 
are specified in the Model Loop component.

For example, a Simulink Gain block might have a string cos(x) instead of a 
number. Simulink looks for a variable x in the workspace and uses the cos 
function. 

Attributes The following figure shows the Simulink Functions and Variables properties 
panel:

Functions Include table of functions
Select this option to include a table of Simulink functions in the generated 
report.
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Table Title
Choose a title for the table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Parent block
Select this option to include a column in the table that includes the name 
of the block, which contains the reported variable.

Calling string
Select this option to include the piece of M-code that calls the reported 
variable.

Include fixed point functions (sfix,ufix,sint,...)
Select this option to include fixed-point functions. If you use any fixed-point 
functions in your model and want those functions to appear in the 
generated report, select this option.

Variables Include table of variables
Select this option to include a table of Simulink variables in the generated 
report.

Table title
 Choose a title for the table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Include Workspace I/O parameters
Select this option to report on variables that contain parameters with time 
vectors and state matrices. These parameters are set in the Workspace 
I/O pane in the Simulation Parameters dialog box in a Simulink model.
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In the following table, if any of the entries in the first column are on, the 
component looks for the variable listed in the second column in the 
workspace. If the component finds the variable, it includes it in the report.

Parent block
Select this option to include the name of the block that contains the 
reported variable.

Calling string
Select this option to include the piece of M-code that calls the reported 
variable. 

Size of variable
Select this option to include the size of the reported variable. 

Memory size
Select this option to include the amount of memory in bytes that the 
reported variable needs. 

Class of variable
Select this option to include the variable class to which the reported 
variable belongs. 

Value in workspace
Select this option to include the actual value of the reported variable. Note 
that very large arrays might be displayed as [MxN CLASS]. For example, if 
you have a 300-by-200 double array, it appears in the report as [300x200 
DOUBLE].

RTW storage class

LoadExternalInput ExternalInput

SaveTime TimeSaveName

SaveState StateSaveName

SaveOutput OutputSaveName

LoadInitialState InitialState

SaveFinalState FinalStateName
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Select this option to include the storage class of the reported variable. The 
title of this column is Storage Class.

This option looks at the model’s TunableVars property to see if any of the 
model variables specify their storage class. If the storage class is specified, 
then the model variables table displays TunableVarsStorageClass and 
TunableVarsTypeQualifier in a table column. The column entries are 
TunableVarsStorageClass (TunableVarsTypeQualifier) if 
TunableVarsTypeQualifier is not empty. If TunableVarsTypeQualifier is 
empty, the column entry is TunableVarsStorageClass.

The values for TunableVarsStorageClass are

- Exported Global

- Auto

- ImportedExtern

- ImportedExtern Pointer

Data object properties
Enter data object properties to report on.

Example
This is an example of a table created by the Model Variables component. This 
property table reports on the variables in the Controller in the F14 demo 
model. 

Insert Anything 
into Report?

Yes. Table.

Variable 
Name

Parent Blocks Calling 
String

Value

Ka f14/Controller/Gain3 Ka 0.677 

Kf f14/Controller/Gain Kf -1.746 

Ki f14/Controller/Proportional 
plus integral compensator 

[Ki] -3.864 

Kq f14/Controller/Gain2 Kq 0.8156 
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Filename rptgen_sl.csl_obj_fun_var
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4Simulink Library InformationCategory Simulink

Description The Simulink Library Information component inserts a table that lists any 
library links in the currect model, system, or block.

Attributes The following figure shows the Simulink Library Information properties 
panel:

Table Columns Block
Select this option to include the Simulink block name in the generated 
table.

Library
Select this option to include the Simulink library root name in the 
generated table.

Reference block
Select this option to include the Simulink reference block name in the 
generated table.
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Link status
Select this option to include the link status in the generated table.

Display 
Options

Title
Enter a title for the display in the generated report. 

Sort table by
To sort the table by block name, select Block. To sort the table by library 
name, select Library. To sort the table by reference block name, select 
Reference Block. To sort the table by link status, select Link Status.

Merge repeated rows
Select this option to merge sorted rows in the generrated table.

Example
If you select the Merge repeated rows option, the generated table will collapse 
identical rows into one. For example, the following table, which is sorted on the 
Reference Block column, is generated from the aero_guidance model without 
the option selected:

Block Library Reference Block Status

Equations 
of Motion 
(Body 
Axes)

aerospace Equations of Motion (Body Axes) resolved

Incidence 
& Airspeed

aerospace Incidence & Airspeed resolved

Fin 
Actuator

aerospace 2nd Order Non-linear Actuator resolved

3DoF 
Animation

aerospace 3DoF Animation resolved

Atmospher
e

aerospace Atmosphere model resolved
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With the Merge repeated rows option selected, the generated table collapses 
rows in the Block column so that each row in the Reference Block column is 
unique: 

Cm simulink Interpolation (n-D) using 
PreLookup

resolved

Cx simulink Interpolation (n-D) using 
PreLookup

resolved

Cz simulink Interpolation (n-D) using 
PreLookup

resolved

Kg simulink Interpolation (n-D) using 
PreLookup

resolved

Ki simulink Interpolation (n-D) using 
PreLookup

resolved

Alpha 
Index

simulink PreLookup Index Search resolved

Mach 
Index

simulink PreLookup Index Search resolved

Mach 
Index

simulink PreLookup Index Search resolved

|Alpha| 
Index

simulink PreLookup Index Search resolved

Block Library Reference Block Status

Equations of 
Motion (Body 
Axes)

aerospace Equations of Motion (Body 
Axes)

resolved

Incidence & 
Airspeed

aerospace Incidence & Airspeed resolved

Block Library Reference Block Status



Simulink Library Information

4-161

Insert Anything 
Into Report?

Yes. Table.

Filename rptgen_sl.CLibinfo

Fin Actuator aerospace 2nd Order Non-linear 
Actuator

resolved

3DoF 
Animation

aerospace 3DoF Animation resolved

Atmosphere aerospace Atmosphere model resolved

Cm
Cx
Cz
Kg
Ki

simulink Interpolation (n-D) using 
PreLookup

resolved

Alpha Index
Mach Index
Mach Index
|Alpha| Index

simulink PreLookup Index Search resolved

Block Library Reference Block Status
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4Simulink Linking AnchorCategory Simulink

Description The Simulink Linking Anchor component designates a location to which other 
links point. This component should have the Model Loop, System Loop, Block 
Loop, or Signal Loop component as its parent.

Attributes The following figure shows the Simulink Linking Anchor properties panel:

Insert text
If you want text to appear after the linking anchor, enter the text in this 
field.

Link from current
This option sets the current model, system, block, or signal as the linking 
anchor:

- Select Automatic to select the appropriate model, system, block, or signal 
as a linking anchor automatically. If the Model Loop component is the 
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parent component, then the linking anchor is set on the current model. 
Similarly, if the System Loop, Block Loop, or Signal Loop is the parent 
component, then the linking anchor is inserted for the current system, 
block, or signal, respectively.

- Select Model to set the linking anchor to the current model.

- Select System to set the linking anchor to the current system.

- Select Block to set the linking anchor to the current block.

- Select Signal to set the linking anchor to the current signal.

Note  You should not use the Simulink Linking Anchor component to create 
an anchor for an object that has anchor created elsewhere, such as a loop 
component or summary table component. Each object should have only one 
anchor per report. See the Simulink Summary Table component reference 
page.

Insert Anything 
into Report?

Yes. A link, and possibly text, depending on attribute choices.

Filename rptgen_sl.csl_obj_anchor
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4Simulink NameCategory Simulink

Description The Simulink Name component inserts the name of a Simulink model, system, 
block, or signal into the report.

You can use this component as the first child component of a 
Chapter/Subsection component, which allows the current Simulink model, 
system block, or signal name to be the chapter or section title.

Attributes The following figure shows the Simulink Name properties panel:

Display name as
Select one of the options listed below to display the Simulink object name 
in the report:

- Name — E.g., f14

- Type Name — E.g., Model f14

- Type - Name — E.g., Model - f14

- Type: Name — E.g., Model: f14
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Object types
- Select Automatic to automatically select the appropriate model, system, 

block, or signal name as the Simulink object name to include in the report. 
If the Model Loop component is the immediate parent component, then the 
object name is the current model name. Similarly, if the System Loop, 
Block Loop, or Signal Loop is the parent component, then the object name 
is the name of the current system, block, or signal, respectively.

- Select Model to include the current model name in the report.

- Select System to include the current system name in the report.

- Select Block to include the current block name in the report.

- Select Signal to include the current signal name in the report. If the signal 
name is empty, then the signal <handle> is included in the report. The 
signal handle is a unique numerical identifier to that signal.

Show full path name
Select this option to show the full pathname for a system or block. For 
example, if you choose this option for a block, the Simulink block name 
appears as <Model Name>/<System Name>/<Block Name>. Note that this 
option is not available for models and signals.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen_sl.csl_obj_name
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4Simulink PropertyCategory Simulink

Description The Simulink Property component inserts a single property name/property 
value pair for the current Simulink model, system, block, or signal.

Attributes The following figure shows the Simulink Property properties panel:

Simulink 
Object and 
Parameter

Object type
Choose the Simulink object type to include in the report:

- System
- Model
- Block

- Signal

System parameter name
Enter a Simulink parameter name to include in the generated report. If 
Model is selected in Object type, this option appears as Model parameter 
name. If Block is selected in Object type, this option appears as Block 
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parameter name. If Signal is selected in Object type, this option appears 
as Signal parameter name.

Display 
Options

Title
Choose a title for the display in the generated report. To use the parameter 
name as the title, select Automatic. To enter a title, select Custom. To 
specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated report. Units 
are in pixels. When creating a table, the size limit is the hypotenuse of the 
table width and height [sqrt(w^2+h^2)]. When creating text, the size limit 
is the number of characters squared. If the size limit is exceeded, the 
variable is rendered in condensed form, such as [64x64 double]. Setting a 
size limit of zero will ignore the size limit and always display the variable, 
no matter how large.

Display as
Choose a display style from the menu:

- Auto table/paragraph — Displays as a table or paragraph based on the 
information.

- Inline text — Displays as inline, which fits in line with the surrounding 
text.

- Paragraph — Displays as a text paragraph.

- Table — Displays as a table.

Ignore if value is empty
Select this option to exclude the parameter from the generated report if the 
parameter is empty.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen_sl.csl_property
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4Simulink Property TableCategory Simulink

Description The Simulink Property Table component inserts a table that reports on 
model-level property name/property value pairs.

Attributes The following figure shows the Simulink Property Table properties panel:

Select Object
Choose the object for the property table in the generated report:

- Model
- System
- Block

- Signal

For more information about selecting object types in property table 
components, see “Selecting Object Types” on page 3-22.

Table A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table list in the upper left corner of the attributes 
page. To apply a preset table, select the table and click Apply.
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Preset table
Choose a type of table to display the object property table:

- Defaults
- Callbacks
- Graphics
- Printing
- Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into separate 
cells. To have the property name and property value appear in adjacent 
horizontal cells in the table, select the Split property/value cells check 
box. In this case, the table is in split mode and there can be only one 
property name/property value pair in a cell. If you have more than one 
name/property pair in a cell, then only the first pair is displayed in the 
report. All subsequent pairs are ignored.

To have the property name and property value appear together in one cell, 
deselect Split property/value cells. This is nonsplit mode. In nonsplit 
mode, you can have more than one property name/property value pair and 
you can also have text.

If you want to switch from nonsplit mode to split mode, make sure that you 
only have one property name/property value pair per table cell before you 
switch modes. If you have more than one property name/property value 
pair or any text, then only the first property name/property value pair 
appears in the report; subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the generated 
report.

Table Cells
Use this field to select table properties to modify. The selection in this pane 
affects the available fields in the Cell Properties pane.

Cell Properties The visible options in the Cell Properties pane depend on the object selected 
in the Table Cells pane. If %<Name> Information is selected, only the Contents 
and Show options are displayed. If any other object is selected in the Table 
Cells pane, the Alignment, Lower border, and Right border options display.
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Contents
Use this field to modify the contents of the table cell selected in the Table 
Cells pane.

Alignment
Choose the alignment of the contents of the selected table cell in the Table 
Cells pane:

- Left
- Center
- Right
- Double justified

Show as
Choose the format for the contents of the table cell:

- Value
- Property Value
- PROPERTY Value
- Property: Value
- PROPERTY: Value
- Property - Value
- PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the generated 
report.

Right border
Select this option to display the right border of the table in the generated 
report.

Creating Custom Tables
To create a custom table, you can first select a preset table and then edit it. You 
might want to start with the Blank 4x4 preset table. You can add and delete 
rows and you can add properties. To open the Edit Table dialog box, click the 
Edit button. The dialog box appears:
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For more information about using this dialog box to create custom property 
tables, see “Working with Property Table Components” on page 3-11.

Note that if you do not have Real-Time Workshop®, Summary (req RTW) is not 
listed in this list, because summary properties require Real-Time Workshop. If 
you are using a setup file that contains a summary property, then the property 
name appears in the report, but the property value does not.

Example
The table below is an example of a model property table. It is the Simulation 
Parameters preset table. This property table is reporting the F14 demo model.

Insert Anything 
into Report?

Yes. Table.

 Solver ode45  ZeroCross on  StartTime 0.0 StopTime 60 

 RelTol 1e-4  AbsTol 1e-6  Refine 1 

 InitialStep auto  FixedStep auto  MaxStep auto 

 LimitMaxRows off  MaxRows 1000  Decimation 1 
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Filename rptgen_sl.csl_prop_table
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4Simulink Summary TableCategory Simulink

Description The Simulink Summary Table component shows properties or parameters of 
the selected Simulink models, systems, blocks, or signals in a table.

Attributes The following figure shows the Simulink Summary Table properties panel:

Object type
Choose the object type to display in the generated report:

- Model
- System
- Signal
- Block

The menu item selected in this menu affects the options available in the 
Property Columns pane.
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Table title
Choose a title for the summary table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Property 
Columns

Property columns
This figure displays the object properties to be included in the summary 
table in the generated report. To add a property, select the appropriate 
property level in the text box. Next, in the contextual list below the text 
box, select the property that you want to add and click the Add button . 
To delete a property, select the property name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary table in 
the generated report. Entered widths should be in percentages.

Object Rows Insert anchor for each row
Select this option to insert an anchor for each row in the summary table.

Report On Automatic list from context
Select this option to report on all blocks in the current context. The context 
is set by the parent of the Simulink Summary Table component.

Custom - use block list
Select this option to report on a list of blocks that you specify, and enter the 
block names in the corresponding field. You must use the full pathname 
when specifying blocks. If you want to sort the blocks in this list, select the 
Sort blocks in list option and then select a sorting option from the Sort 
blocks list (in the Loop Options section). Blocks are reported on in the 
order that they are sorted. If you do not select this option, blocks are 
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details.
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For example, if you want to report on the theta dot integrator block and 
the theta integrator block in the demo model simppend, you could enter the 
following in the block list.

simppend/theta dot

%<Z>

If you define Z in the workspace as the following,

Z={'simppend/theta'}

then the Report Generator reports on the following blocks:

simppend/theta dot

simppend/theta

Loop Options You can choose block sorting options and reporting options in this pane.

Sort blocks
Use this option to select how the blocks are sorted:

- Select Alphabetically by block name to sort blocks alphabetically by 
their names.

- Select Alphabetically by system name to sort systems alphabetically.

In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select Alphabetically by full Simulink path to sort blocks 
alphabetically by Simulink path.

- Select By block type to sort blocks alphabetically by block type.

- Select By block depth to sort blocks by their depth in the model.

- Select By traversal order to sort blocks by traversal order. 

- Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields. 
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Example
If you are reporting on the demo model F14, and you choose the following 
options, then the summary table shown below is generated:

- Sort on systems by system depth.

- Name and blocks are the system parameters to be included in the table.

 Name  Blocks 

 f14 u, Actuator Model, Aircraft Dynamics 
Model, Angle of Attack, Controller, 
Dryden Wind Gust Models, Gain, Gain1, 
Gain2, Gain5, More Info, More Info1, Nz 
pilot calculation, Pilot, Pilot G force 
Scope, Stick Input, Sum, Sum1, alpha 
(rad), Nz Pilot (g) 

 Aircraft Dynamics Model Elevator Deflection d (deg), Vertical Gust 
wGust (ft/sec), Rotary Gust qGust 
(rad/sec), Gain3, Gain4, Gain5, Gain6, 
Sum1, Sum2, Transfer Fcn.1, Transfer 
Fcn.2, Vertical Velocity w (ft/sec), Pitch 
Rate q (rad/sec) 

 Controller Stick Input (in), alpha (rad), q (rad/sec), 
Alpha-sensor Low-pass Filter, Gain, 
Gain2, Gain3, Pitch Rate Lead Filter, 
Proportional plus integral compensator, 
Stick Prefilter, Sum, Sum1, Sum2, 
Elevator Command (deg) 

 Dryden Wind Gust Models Band-Limited White Noise, Q-gust 
model, W-gust model, Wg, Qg 

 More Info   



Simulink Summary Table

4-177

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sl.csl_summ_table

 More Info1   

 Nz pilot calculation w, q, Constant, Derivative, Derivative1, 
Gain1, Gain2, Product, Sum1, Pilot g 
force (g) 

 Name  Blocks 
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4State LoopCategory Stateflow

Description The State Loop component runs its children for all states in its context. For 
example, if a State Loop component is parented by a Model Loop component, 
the State Loop component’s context is the Model Loop. If the State Loop has no 
context, it loops on all states in all open models.

When using the State Loop component, keep the following points in mind:

• If the State Loop has the Model Loop as its parent, it includes all states in  
the models.

• If the State Loop has the System Loop as its parent, it includes all states in 
the systems.

• If the State Loop has the Machine Loop as its parent, it includes all states in 
the machines.

• If the State Loop has the Chart Loop as its parent, it includes all states in 
the charts.

• If the State Loop has another State Loop as its parent, it includes all states 
in the current state. Use this context with a shallow loop. 

Attributes The following figure shows the State Loop properties panel:
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State Types Include “and” and “or” states
Select this option to include AND and OR states in the loop.

Include “box” states
Select this option to include “box” states in the loop.

Include functions
Select this option to include “function” states in the loop.

Include truth tables
Select this option to include truth tables in the loop.

Include embedded MATLAB functions
Select this option to include Embedded MATLAB functions in the loop.

Loop Options Report depth
Select the level on which to loop:

- All objects
- Local children only
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Skip autogenerated charts under truth table
Select this option to keep autogenerated state objects under truth tables 
from being displayed in the report.

Search states
Select this option to indicate specific states to include in the loop.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is selected.

Filename rptgen_sf.csf_state_loop



Stateflow Automatic Table

4-181

4Stateflow Automatic TableCategory Stateflow

Description The Stateflow Automatic Table component inserts a table that contains the 
properties of the current Stateflow object as set in a Machine Loop component, 
State Loop component, Chart Loop component, or Object Loop component.

Attributes The following figure shows the Stateflow Automatic Table properties panel:

Display 
Options

Table title
Use this option to select a title for the table in the generated report. To  
include no title, select No title. To use a name as the title, select Name. To 
include a custom title, select Custom. 

If Name is selected, select one of the following options:

- Object name
- Object name with Stateflow path
- Object name with Simulink and Stateflow path

Header row
Use this option to select a header row for the table in the generated report. 
To include no header row, select No header. To include a header row with 
columns for name and object type, select Type and Name. When selected, 
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this option creates a header row for the table with object name and type. To 
include a custom header, select Custom.

Don’t display empty values
Select this option to exclude empty values from the generated report.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sf.csf_auto_table
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4Stateflow CountCategory Stateflow

Description The Stateflow Count component counts the number of Stateflow objects in the 
current context, such as system, model, signal, and so on. See the Stateflow 
documentation for a description of Stateflow objects.

Attributes The following figure shows the Stateflow Count properties panel:

Search depth
Choose the search depth for the count:

- All descendants — Searches all children of the Stateflow object.
- Immediate children only — Searches only children one level below the 

Stateflow object. 

Sort results
Choose the sort method for the count results:

- Numerically decreasing by object count

- Alphabetically increasing by object type



Stateflow Count

4-184

Include a list of objects in table
Select this option to insert a column containing the counted objects.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sf.csf_count
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4Stateflow FilterCategory Stateflow

Description The Stateflow Filter component is a filter that runs its children only if the 
current object type (set by the parent Stateflow Hierarchy Loop component) 
matches the selected object type. The Stateflow Filter component must have 
the Stateflow Loop component as its parent.

Attributes The following figure shows the Stateflow Filter properties panel:

Object type
Choose the Stateflow object type to include in the report. The current object 
type (set by the parent State Loop) must match this selected object type in 
order for the current object to be included in the report. 

Run only if Stateflow object has at least the following number of Stateflow 
children

Use this option to limit the number of Stateflow objects that is reported on. 
If you enter a number in this field, a Stateflow object is not included in the 
report unless it has at least that number of children.
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Automatically insert linking anchor
Select this option to insert a linking anchor before the reported object. If an 
anchor for this object already exists (inserted by the Stateflow Linking 
Anchor component), a second anchor is not created.

Insert Anything 
into Report?

No.

Filename rptgen_sf.csf_obj_filter
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4Stateflow HierarchyCategory Stateflow

Description The Stateflow Hierarchy component inserts a tree representation that 
describes the Stateflow object’s hierarchy.

Attributes The following figure shows the Stateflow Hierarchy properties panel:

Tree Options Construct tree from
Select the object to use for the tree representation.

- Current object

- Root of current object — Starts from the top of the hierarchy.

Emphasize current object in tree
Select this option to highlight the current object in the tree representation.
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Show number of parents
Enter the number of parents to allow in the tree representation.

Show siblings
Select this option to display siblings in the tree represenation.

Show children to depth
Enter the depth of children to display for each object in the tree 
representation.

Children Show junctions
Select the level of junction detail to display in the generated report.

- All 

- Non-redundant

- None 

Show transitions
Select the level of transition detail to display in the generated report.

- All
- Labeled or non-redundant
- Non-redundant
- Labeled
- None

Skip autogenerated charts under truth tables
Select this option to not include autogenerated charts beneath truth tables.

List Formatting List style
Select either Bulleted list or Numbered list. If you choose Numbered 
list, then you can select numbering options in the Numbering style 
section.

Numbering style
Select a numbering style from the menu.

- 1,2,3,4...
- a,b,c,d...
- A,B,C,D...
- i,ii,iii,iv...
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- I,II,III,IV...

To show the parent number in each list entry, select Show parent number 
in nested list (1.1.a). To show only the current number or letter, select 
Show only current list value (a).

Insert Anything 
into Report?

Yes. Tree.

Filename rptgen_sf.csf_hier
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4Stateflow Hierarchy LoopCategory Stateflow

Description The Stateflow Hierarchy Loop component runs its child components on the 
Stateflow object hierarchy.

Attributes The following figure shows the Stateflow Hierarchy Loop properties panel:

Loop Options Minimum legible font size
Enter the minimum font size to use in the report. The default font size, 8, 
is the smallest recommended font size.  

Skip autogenerated charts under truth tables
Select this option to exclude autogenerated charts under truth tables in the 
report.
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Search Stateflow
Select this option to report only on Stateflow charts with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

No.

Filename rptgen_sf.csf_hier_loop



Stateflow Linking Anchor

4-192

4Stateflow Linking AnchorCategory Stateflow

Description The Stateflow Linking Anchor component designates a location to which other 
links point. The linking anchor is set to the current object, which is defined by 
the parent component. This component must have the Chart Loop, State Loop, 
Machine Loop, Terminal Loop, or Stateflow Filter component as its parent.

Attributes The following figure shows the Stateflow Linking Anchor properties panel:

Insert text
If you want text to appear after the linking anchor, enter the text in this 
field.

Note  You should not use the Stateflow Linking Anchor component to create 
an anchor for an object that is anchored in the object summary table. See the 
Simulink Summary Table component reference page.
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Insert Anything 
into Report?

Yes. A link, and possibly text, depending on attribute choices.

Filename rptgen_sf.csf_obj_anchor
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4Stateflow NameCategory Stateflow

Description The Stateflow Name component inserts the name of the Stateflow object 
specified by its parent component into the report. This component must have 
the State Loop, Chart Loop, or Stateflow Filter component as its parent.

You can use this component as the first child component of a 
Chapter/Subsection component, which allows the current Stateflow object 
name to be the chapter or section title.

Attributes The following figure shows the Stateflow Name properties panel:

Display name as
Select one of the options listed below to display the Stateflow object name 
in the report:

- Name — E.g., Object

- Type Name — E.g., Object <ObjectName>
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- Type - Name — E.g., Object - <ObjectName>

- Type: Name — E.g., Object: <ObjectName>

Display name as
Select one of the options listed below to display the Stateflow object name 
in the report:

- Object name
- Object name with Stateflow path
- Object name with Simulink and Stateflow path

Insert Anything 
into Report?

Yes. Text.

Filename rptgen_sf.csf_obj_name
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4Stateflow Object LoopCategory Stateflow

Description The Stateflow Object Loop component runs its child components for each 
Stateflow object. The component inserts a table into the generated report.

Attributes The following figure shows the Stateflow Object Loop properties panel:

Object Types Report on "Data" objects
Select this option to include Stateflow data objects in the loop.

Report on "Event" objects
Select this option to include Stateflow event objects in the loop.

Report on "Transition" objects
Select this option to include Stateflow transition objects in the loop.

Report on "Junction" objects
Select this option to include Stateflow junction objects in the loop.
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Report on "Target" objects
Select this option to include Stateflow target objects in the loop.

Report on Note objects
Select this option to include Stateflow note objects in the loop.

Loop Options Report depth
Select the level on which to loop.

- All objects — Reports on all Stateflow objects.

- Local children only — Reports only on children one level down.

Skip autogenerated charts under truth tables
Select this option to exclude autogenerated charts under truth tables from 
the report.

Remove objects which do not contain more information than a 
snapshot

Select this option to exclude objects that only contain a snapshot. Other 
information can include a document link or a description.

Search Stateflow
Select this option to report only on Stateflow charts with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the Stateflow object in the 
generated report.

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is selected.
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Filename rptgen_sf.csf_obj_loop
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4Stateflow PropertyCategory Stateflow

Description The Stateflow Property component inserts a table, text, or paragraph that 
contains details of the selected Stateflow object property.

Attributes The following figure shows the Stateflow Property properties panel:

Property to 
Display

Property name
Enter the Stateflow property name to display.

Display 
Options

Title
Choose a title for the display in the generated report. To use the parameter 
name as the title, select Automatic. To enter a title, select Custom. To 
specify no title, select None.

Size limit
Use this size to limit the width of the display in the generated report. Units 
are in pixels. When creating a table, the size limit is the hypotenuse of the 
table width and height [sqrt(w^2+h^2)]. When creating text, the size limit 
is the number of characters squared. If the size limit is exceeded, the 
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variable is rendered in condensed form, such as [64x64 double]. Setting a 
size limit of zero will ignore the size limit and always display the variable, 
no matter how large.

Display as
Choose a display style from the menu:

- Auto table/paragraph — Displays as a table or paragraph based on the 
information.

- Inline text — Displays as inline, which fits in line with the surrounding 
text.

- Paragraph — Displays as a text paragraph.

- Table — Displays as a table.

Ignore if value is empty
Select this option to exclude empty parameters in the generated report.

Insert Anything 
into Report?

Yes. Text, paragraph, or table.

Filename rptgen_sf.csf_property
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4Stateflow Property TableCategory Stateflow

Description The Stateflow Property Table component inserts a property-value table for a 
Stateflow object into the report. This object is defined by the Stateflow Filter 
component, which must be the parent of the Stateflow Property Table. For 
more information about working with property table components, see 
“Working with Property Table Components” on page 3-11.

Attributes The following figure shows the Stateflow Property Table properties panel:

Table A preset table is a table that is already formatted and set up. You can select a 
preset table in the preset table list in the upper left corner of the attributes 
page. To apply a preset table, select the table and click Apply.

Preset table
Choose a type of table to display the object property table:

- Defaults
- Callbacks
- Graphics
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- Printing

- Blank 4x4

Split property/value cells
Select this option to split property name/property value pairs into separate 
cells. To have the property name and property value appear in adjacent 
horizontal cells in the table, select the Split property/value cells check 
box. In this case, the table is in split mode and there can be only one 
property name/property value pair in a cell. If you have more than one 
name/property pair in a cell, then only the first pair is displayed in the 
report. All subsequent pairs are ignored.

To have the property name and property value appear together in one cell, 
deselect the Split property/value cells. This is nonsplit mode. In nonsplit 
mode, you can have more than one property name/property value pair and 
you can also have text.

If you want to switch from nonsplit mode to split mode, make sure that you 
have only one property name/property value pair per table cell before you 
switch modes. If you have more than one property name/property value 
pair or any text, then only the first property name/property value pair 
appears in the report; subsequent pairs and text are omitted.

Display outer border
Select this option to display the outer border of the table in the generated 
report.

Table Cells
Use this field to select table properties to modify. The selection in this pane 
affects the available fields in the Cell Properties pane.

Title Properties The visible options in the Title Properties pane depend on the object selected 
in the Table Cells pane. If %<Name> is selected, only the Contents and Show 
options is displayed. If any other object is selected in the Table Cells pane, the 
Alignment, Lower border, and Right border options is displayed.

Contents
Use this field to modify the contents of the table cell selected in the Table 
Cells pane.
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Alignment
Choose the alignment of the contents of the selected table cell in the Table 
Cells pane:

- Left
- Center
- Right

- Double justified

Show as
Choose the format for the contents of the table cell:

- Value
- Property Value
- PROPERTY Value
- Property: Value
- PROPERTY: Value
- Property - Value

- PROPERTY - Value

Lower border
Select this option to display the lower border of the table in the generated 
report.

Right border
Select this option to display the right border of the table in the generated 
report.

Creating Custom Tables
To create a custom table, you can first select a preset table and then edit it. You 
might want to start with the Blank 4x4 preset table. You can add and delete 
rows and you can add properties. To open the Edit Table dialog box, click the 
Edit button. The dialog box appears:
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For more information about using this dialog box to create custom property 
tables, see “Working with Property Table Components” on page 3-11.

Note that available properties and preset tables depend on the Stateflow Filter 
parent component.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sf.csf_prop_table
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4Stateflow SnapshotCategory Stateflow

Description The Stateflow Snapshot component inserts a snapshot of a Stateflow object 
(defined by the Stateflow Filter component) into the report. The Stateflow 
Snapshot component must have the Stateflow Filter component as its parent.

This component only executes if the selected object in the Stateflow Filter 
component is a graphical object. The following are graphical Stateflow objects:

• Chart

• State

• Transition

• Frame

Attributes The following figure shows the Stateflow Snapshot properties panel:

Image Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic SF Format to automatically choose the format best suited for 
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the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic SF 
Format is the default option. The options include

- Automatic SF Format (uses the Handle Graphics file format selected in 
the Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
- Bitmap (256-color)
- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed
- Windows metafile

Size menu
Choose the aspect ratio for the snapshot in the generated report:

- Custom (maintain aspect ratio)

- Shrink image to minimum font size set in Stateflow Loop

Maximum size
Enter the maximum size for the snapshot in the generated report in the 
selected units. Use [width height] format. In the units text box, select 
Inches, Centimeters, Points, or Normalized. 
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Properties Include callouts to describe visible objects
Select this option to display descriptive callouts for visible objects.

Insert anchors for transitions and junctions
Select this option to insert anchors for transitions and junctions into the 
report.

- None
- Redundant children only
- All

Run only if Stateflow object has at least the following number of children

To run this component only when the current Stateflow object has at least 
a certain number of children, enter that number in this field. The current 
Stateflow object is specified by the Stateflow Filter component. This option 
is not active unless the selected object in the Stateflow Filter (the parent 
component) is a graphical object.

This option lets you decrease the size of the report by excluding certain 
images. You might want to use this option when you have a large model.

Image title
Choose No title, Object name, Object name (full Stateflow path), 
Object name (full Simulink and Stateflow path), or Custom to specify 
whether or not you want a title for the image. The default is no title. If you 
choose Custom, then you need to type in the title you want to appear.

Insert Anything 
into Report?

Yes. Image.

Filename rptgen_sf.csf_obj_snap
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4Stateflow Summary TableCategory Stateflow

Description The Stateflow Summary Table component shows properties or parameters of 
the selected Stateflow objects in a table. The Stateflow Summary Table 
component can have the following parents:

• Any Stateflow looping component, except Terminal Loop

• Any Simulink looping component (Model Loop, System Loop, Block Loop, or 
Signal Loop)

Attributes The following figure shows the Stateflow Summary Table properties panel:

Object type
Choose the object type to display in the generated report. The menu item 
selected in this menu affects the options available in the Property 
Columns pane.
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Table title
Choose a title for the summary table in the generated report:

- Automatic — Select this option to generate a title automatically from the 
parameter.  

- Custom — Select this option to enter a title manually.

Property 
Columns

Property columns
This figure displays the object properties to be included in the summary 
table in the generated report. To add a property, select the appropriate 
property level in the text box. Next, in the contextual list below the text 
box, select the property that you want to add and click the Add button . 
To delete a property, select the property name and press the Delete key.

Relative column widths
Use this option to enter relative column widths for the summary table in 
the generated report. Entered widths should be in percentages.

Object Rows Insert anchor for each row
Select this option to insert an anchor for each row in the summary table.

Report On Automatic list from context
Select this option to report on all blocks in the current context. The context 
is set by the Stateflow Summary Table component’s parent component.

Custom - use block list
Select this option to report on a list of blocks that you specify and enter the 
block names in the corresponding field. You must use the full pathname 
when specifying blocks. If you want to sort the blocks in this list, select the 
Sort blocks in list option and then select a sorting option from the Sort 
blocks list (in the Loop Options section). Blocks are reported on in the 
order that they are sorted. If you do not select this option, blocks are 
reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details.



Stateflow Summary Table

4-210

For example, if you want to report on the theta dot integrator block and 
the theta integrator block in the demo model simppend, you could enter the 
following in the block list.

simppend/theta dot

%<Z>

If you define Z in the workspace as the following,

Z={'simppend/theta'}

then the Report Generator reports on the following blocks:

simppend/theta dot

simppend/theta

Loop Options You can choose block sorting options and reporting options in this pane.

Sort blocks
Use this option to select how the blocks are sorted:

- Select Alphabetically by block name to sort blocks alphabetically by 
their names.

- Select Alphabetically by system name to sort systems alphabetically.

In this option, the systems are sorted alphabetically, and blocks in each 
system are listed, but in no particular order.

- Select Alphabetically by full Simulink path to sort blocks 
alphabetically by Simulink path.

- Select By block type to sort blocks alphabetically by block type.

- Select By block depth to sort blocks by their depth in the model.

- Select By traversal order to sort blocks by traversal order. 

- Select By simulation order to sort blocks by execution order.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.
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Search Stateflow
Select this option to report only on Stateflow charts with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sf.csf_summ_table
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4Stop Report GenerationCategory Report Generator

Description The Stop Report Generation component halts report generation. This 
component acts like the Stop button during report generation.

You can use this component inside an if/then statement by using Logical and 
Flow Control components to halt the report generation process under a certain 
condition. Note that when report generation is halted, the XML source file is 
produced, but not converted.

Attributes The following figure shows the Stop Report Generation properties panel:

Confirmation 
Properties

Confirm before stopping generation
Select this option to generate a confirmation dialog box before stopping 
report generation.

Confirmation question
Enter a confirmation question for the prompt.
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Halt button name
Enter a name for the button that stops report generation.

Continue button name
Enter a name for the button that continues report generation.

Example
The setup file in this example creates a simple report that takes a snapshot of 
the current figure. If there is no current figure, the report generation 
automatically halts.

[-] Report - figure-report.rpt
[-] if (isempty(get(0,'CurrentFigure')))

[ ] Stop Generation
[-] Figure Loop - current

[-] Chapter - <Title from SubComponent1>
[ ] Figure Name
[ ] Graphics Figure Snapshot
[ ] Figure Prop Table - Figure Properties

Insert Anything 
into Report?

No.

Filename rptgen.crg_halt_gen
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4System FilterCategory Simulink

Description The System Filter component runs child components only if the current 
systems meets the conditions specified in the attribute page.

Attributes The following figure shows the System Filter properties panel:

Report only if system has at least N blocks
Enter a number to execute child components only if there are at least the 
specified number of blocks in the system. Note that if you enter 0, then 
there is no filtering; child components are executed regardless of the 
number of blocks in the system.

Report only if system has at least N subsystems
Enter a number to execute child components only if there are at least the 
specified number of subsystems in the system. Note that if you enter 0, 
then there is no filtering; child components are executed regardless of the 
number of subsystems in the system.
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Report only if system mask type is
Choose what masks to include in the generated report:

- Either masked or unmasked
- Masked
- Unmasked

Insert Anything 
into Report?

No.

Filename rptgen_sf.csf_obj_filter
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4System HierarchyCategory Simulink

Description The System Hierarchy component creates a nested list that shows the 
hierarchy of the system specified in the attribute page. The list can display all 
systems in a model or it can show the parents and children of the current 
system.

Attributes The following figure shows the System Hierarchy properties panel:

Starting 
System

Build list from
Select the system or model from which the list will be built. 

- Current system

- Current model

Emphasize current system
Select this option to highlight the current system or model in the generated 
report.
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Display 
Systems

Show number of parents
Enter the number of parents to list. 

Display peers of current system
Select this option to show the current system’s peers in the generated 
report.

Show children to depth
Enter the depth of children to list.

List Formatting List style
Select either Bulleted list or Numbered list. If you choose Numbered 
list, then you can select numbering options in the Numbering style 
section.

Numbering style
Select a numbering style in this drop-down menu if you selected Numbered 
List for the List style. The options are

- 1,2,3,4,...

- a,b,c,d,...

- A,B,C,D,...

- i,ii,iii,iv,...

- I,II,III,IV,... 

Insert Anything 
into Report?

Yes. List.

Filename rptgen_sl.csl_sys_list
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4System LoopCategory Simulink

Description The System Loop component runs its child components for each system defined 
by the Model Loop. The System Loop component must have the Model Loop 
component as its parent.

Attributes The following figure shows the System Loop properties panel:

Report On Loop on Systems
Select systems automatically

Select the Select systems automatically option to report on all systems 
in the current context. The context is set by the System Loop component’s 
parent component:

- If the parent component is the Model Loop, then selecting this option 
causes the System Loop component to report on systems in the current 
model.
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- If the parent component is another System Loop, then selecting this option 
causes the System Loop component to report on the current system.

- If the parent component is the Signal Loop, then selecting this option 
causes the System Loop component to report on the current signal’s parent 
system.

- If the parent component is the Block Loop, then selecting this option 
causes the System Loop component to report on the current block’s parent 
system.

- If the System Loop does not have the Model Loop, System Loop, Signal 
Loop, or Block Loop component as its parent, then selecting this option 
causes the System Loop component to report on all systems in all models.

Custom - use system list
Select this option to report on a list of systems that you specify, and enter 
the system names in the corresponding field. You must use the full 
pathname when specifying systems. If you want to sort the systems in this 
list, select the Sort systems in list option and then select a sorting option 
from the Sort Systems option (in the Loop Options section). Systems are 
reported on in the order that they are sorted. If you do not select this option, 
systems are reported on in the order that they are listed in the block list.

You can enter %<VariableName> if you want to insert the value of a variable 
from the MATLAB workspace. The %<> notation can be a string or cell 
array. See “%<VariableName> Notation” in the Text component reference 
page for more details.

For example, if you want to report on the Controller system and the Nz 
pilot calculation system in the demo model f14, you could enter the 
following in the block list:

f14/Nz pilot calculation

%<Z>

If you define Z in the workspace as the following,

Z={'f14/Controller'}

then the Report Generator reports on the following systems.

f14/Nz pilot calculation

f14/Controller
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Loop Options Sort Systems
Use this section to select how the systems are sorted:

- Select By number of blocks in system to sort systems by the number of 
blocks in the system. The list shows systems by decreasing number of 
blocks; i.e., the system with the largest number of blocks is listed first.

- Select Alphabetically by system name to sort systems alphabetically by 
name.

- Select By traversal order to sort systems in the order they are traversed.

- Select By system depth to sort systems by their depth in the model.

Search for Simulink property name/property value pairs
Select this option to report only on Simulink blocks with certain property 
name/property value pairs. Enter the property name and the property 
value in the appropriate fields. 

Section 
Options

Create section for each object in loop
Select this option to insert a section in the generated report for each object 
found in the loop.

Display the object type in the section title
Select this option to insert the object type automatically into the section 
title in the generated report.

Create link anchor for each object in loop
Select this option to create a hyperlink to the object in the generated report.

Insert Anything 
into Report?

Yes, section, if the Create section for each object in loop option is selected.

Filename rptgen_sl.csl_sys_loop
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4System SnapshotCategory Simulink

Description The System Snapshot component inserts a snapshot of the current system in 
your report.

Attributes The following figure shows the System Snapshot properties panel:

Snapshot Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic SL Format to automatically choose the format best suited for 
the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic SL 
Format is the default option. The options include

- Automatic SL Format (uses the Handle Graphics file format selected in 
the Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
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- Bitmap (256-color)
- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed

- Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use system orientation option. The Use system 
orientation option uses the PaperOrientation parameter in Simulink, 
which you can set as Landscape, Portrait, or Rotated. 

Image Size
Select Automatic to automatically scale the image to output dimensions. 
Select Custom to specify image size. The default for this field is Automatic. 
Note that if Use printframe is selected, the Custom option is deactivated 
and the image is automatically scaled to the print frame size.

Annotation Image title
Choose No title, System name, System name (full path), or Custom to 
specify whether or not you want a title for the image. The default is no title. 
If you choose Custom, then you need to type in the title you want to appear.



System Snapshot

4-223

Image caption
Choose No caption, Automatic (use system description), or Custom to 
specify whether or not you want a caption for the image. The default is no 
caption. If you choose Custom, then you need to type in the caption you want 
to appear.

Use printframe
Choose this option to print a frame around the image. You can use the 
default Report Generator frame, rptdefaultframe.fig , or you can use the 
Frame Editor to build a custom frame.

To build a custom frame, type frameedit at the command line to invoke the 
Print Frame Editor. For help with the Print Frame Editor, select Print 
Frame Editor Help from the Help menu. See frameedit in the Simulink 
reference pages for a discussion of the frameedit command.

The default Report Generator frame is five inches wide and four inches 
high. It includes the name of the system and the model directory. This 
frame is optimized for use with a portrait paper orientation. The Aircraft 
Dynamics Model in the f14 Simulink demo model is shown below with the 
default Report Generator frame option.
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Insert Anything 
into Report?

Yes. Image.

Filename rptgen_sl.csl_sys_snap
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4TableCategory Formatting

Description The Table component converts a rectangular cell array into a table and inserts 
the table into the report.

Attributes The following figure shows the Table properties panel.

Table Content Workspace variable name
Enter the workspace variable name with which to construct the table.

Collapse large cells to a single description
Select this option to consolidate large cells into one description.

Formatting 
Options

Table title
Enter the title of your table. If you have a title for a table, it is included in 
the list of tables if the stylesheet you chose in the Report Options attribute 
page supports it. To find stylesheets that have a list of tables, see Chapter 
2, “Setting the Report Format.”
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Cell alignment
Select a cell alignment option (left, center, right, or double justified).

Column widths
Input a vector with m elements where m equals the number of columns in 
the table. Column sizing is relative and normalized to page width. For 
example, if you have a 2-by-3 cell array and input the following into the 
Column widths field,

     [1 2 3]

then the report output format for the cell array would be the second column 
is twice the width of the first column and the third column is three times 
the width of the first column. Note that if the vector is greater than the 
number of columns in the table, then the vector is truncated so that the 
number of elements equals the number of columns. If m is less than the 
number of columns in the table, then the vector is padded with 1’s so that 
the number of elements equals the number of columns.

Table grid lines
Select this option if you want to have grid lines in your table. Grid lines 
create borders between the fields.

Table spans page width
Select this option if you want the table to have the same width as the page 
on which it appears.

Header/Footer 
Options

Designating a row as a header or footer row causes the contents of the row to 
be displayed in boldface.

Number of header rows
Enter the number of header rows (from the top): 0 = none, 1 = 1 row from 
the top, 2 = two rows from the top, etc.

Footer list
If you do not want a footer, select No footer. If you want to select a footer 
that is different from your header, select Last N rows of cell array are 
footer and enter the number of footer rows (from the bottom) in the 
corresponding field: 0 = none, 1 = one row from the bottom, 2 = two rows 
from the bottom, etc.
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Example
For example, if you have the following cell array in the MATLAB workspace,

{'foo','bar';[3],[5]}

then the resulting cell table has the following appearance.

Note that the table has no headers or footers and no title. The table does have 
grid lines.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen.cfr_table

foo bar

3 5
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4TextCategory Formatting

Description The Text component formats text and inserts it into your report. The text 
component should have the Paragraph component as its parent.

Attributes The following figure shows the Text properties panel:

Text to include in report
Enter the text you want to include in your report in this field.

Show text as syntax-highlighted M-code
Select this option to display text as highlighted M-code.

Emphasize text
If you want to have the text appear italicized in the report, select this 
option.

Retain spaces and carriage returns
If you want to keep spaces and carriage returns in your text, select this 
option. If you do not select this option, the text still inserts one space any 
time you have one or more spaces; it does not keep any carriage returns.
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%<VariableName> Notation
You can enter %<VariableName> in this field (and in any field where the text 
appears blue) to include the value of a variable from the base MATLAB 
workspace. You cannot enter more than one variable in the %<>. If you enter an 
invalid variable name, then the report will contain %<VariableName> instead 
of the value of the variable.

Example 1
If you enter the following,

I have a %<ObjName> and it has %<NumLeaves> leaves. The word 
'%<ObjName>' has %<size(ObjName)> letters.

and if ObjName='plant' and NumLeaves=3 in the MATLAB workspace,

then the report contains the following.

I have a plant and it has 3 leaves. The word 'plant' has 5 letters.

Example 2
If you enter the following,

%<help('peaks')>

then the report contains the text that you get when you type help peaks at the 
command line.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen.cfr_text
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4Time/Date StampCategory Report Generator

Description The Time/Date Stamp component inserts the time and date of the report 
generation into your report as text. It must have the Paragraph or 
Chapter/Subsection component as its parent.

Attributes The following figure shows the Time/Date Stamp properties panel:

Prefix Include text before stamp 
Select this option to include text before the time/date stamp, and enter the 
text in the corresponding field.

Time Stamp 
Properties

Include current time in stamp
Select this option to insert the current time in the time/date stamp.

Time display
Use this option to select the appearance of the time display. The following 
options are available:
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- 12-hour

- 24-hour

Time Separator
Use this option to select a separation marker between hours, minutes, and 
seconds. The following options are available for the separator:

- Blank space ( ) - E.g., Hour Minute Second

- Colon (:) - E.g., Hour:Minute:Second

- Period (.) - E.g., Hour.Minute.Second

- None () - E.g., HourMinuteSecond

Include seconds in time stamp
Select this option to display seconds in the time/date stamp.

Date Stamp 
Properties

Include current date in stamp
Select this option to insert the current date in the time/date stamp.

Date order
Use this option to select the order in which the day, month, and year should 
appear. The following options are available for this order:

- Day Month Year

- Month Day Year

- Year Month Day

Date separator
Use this option to select a separation marker between day, month, and 
year. The following options are available for the separator:

- Blank space ( ) — E.g., Day Month Year

- Colon (:) — E.g., Day:Month:Year

- Slash (/) — E.g., Day/Month/Year

- Period (.) — E.g., Day.Month.Year

- None () — E.g., DayMonthYear

Month display
Use this option to select the appearance of the month display. The following 
options are available for the display:
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- Long (December)

- Short (Dec)

- Numeric (12)

Year display
Use this option to select the appearance of the year display. The following 
options are available for the display:

- Long (1998)

- Short (98)

Preview This pane displays the time/date stamp as it will appear in the report.

Insert Anything 
into Report?

Yes. Text.

Filename rptgen.crg_tds
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4Title PageCategory Formatting

Description The Title Page component creates and inserts a title page at the beginning of 
the report. The Title Page component can be used as a child component to a 
Chapter/Subsection component, or it can be used alone in a setup file.

Attributes The following figure shows the Title Page properties panel:

All the text fields in this attribute page can contain the %<VariableName> 
notation. See “%<VariableName> Notation” in the Text component reference 
page.

Title Title
Enter the title of the report in this field. The title will appear in a large font.

Subtitle
Enter the subtitle in this field. The subtitle will appear under the title, in 
a smaller font than the title.
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Options Image file name
Enter the filename for an image you want to appear on the title page. The 
image will appear under the subtitle.

Author
Enter the author in this field. The author will appear under the subtitle, in 
a smaller font than the subtitle.

Include report creation date
Select this option if you want to include the report creation date, and choose 
the date format in the corresponding list.

Include copyright holder and date
Select this option to include copyright holder and year information.

Abstract
Enter the abstract for the report in this field. This is optional.

Legal notice
Enter the legal notice for the report in this field. This is optional.

Insert Anything 
into Report?

Yes. Title page.

Filename rptgen.cfr_titlepage
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4To Workspace PlotCategory Simulink Blocks

Description The To Workspace Plot component captures a plot figure created in the 
MATLAB workspace. This component inserts a figure and/or table into the 
report; the table contains input and output numeric values, and the figure is a 
plot of the values.

Attributes The following figure shows the To Workspace Plot properties panel:

Print Options Image file format
Choose the image file format (e.g., JPEG, TIFF, etc.) from this list. Select 
Automatic HG Format to automatically choose the format best suited for 
the output format that you chose in the Report component. Otherwise, 
choose an image format that your output viewer can read. Automatic HG 
Format is the default option. The options include

- Automatic HG Format (Uses the Simulink file format selected in the 
Preferences dialog box)

- Adobe Illustrator
- Bitmap (16m-color)
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- Bitmap (256-color)
- Black and white encapsulated PostScript
- Black and white encapsulated PostScript (TIFF)
- Black and white encapsulated PostScript2
- Black and white encapsulated PostScript2 (TIFF)
- Black and white PostScript
- Black and white PostScript2
- Color encapsulated PostScript
- Color encapsulated PostScript (TIFF)
- Color encapsulated PostScript2
- Color encapsulated PostScript2 (TIFF)
- Color PostScript
- Color PostScript2
- JPEG high quality image
- JPEG medium quality image
- JPEG low quality image
- PNG 24-bit image
- TIFF - compressed
- TIFF - uncompressed

- Windows metafile

Paper orientation
You can choose Landscape, Portrait, or Rotated as your paper orientation, 
or you can choose the Use figure orientation option. See the orient 
command for information about paper orientation.

Image size
Select Use figure PaperPositionMode setting to use the 
PaperPositionMode property of the Handle Graphics figure to set the 
image size in the report. See the orient command for information about 
paper position mode.

Select the Automatic (same size as on screen) option if you want the 
image in your report to be the same size as the image on the screen.

Select the Custom option to choose a custom image size. If you choose this 
option, specify the image size in the size and unit fields.
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- Size: Enter the size of the Handle Graphics figure snapshot in the form wxh 
(width times height). This field is active only if you choose Custom in the 
Image size list box.

- Units: Enter the units for the size of the Handle Graphics figure snapshot. 
This field is active only if you choose Set image size in the Custom list 
box.

Invert hardcopy
Handle Graphics figures have an InvertHardcopy property. This 
parameter inverts colors for printing; i.e., it changes dark colors to light 
colors and vice versa. 

Select one of the following options:

- Automatic — Select this option to automatically change dark axes colors 
to a light axes color. If the axes color is a light color, then it is not inverted.

- Invert — Select this option to change dark axes colors to light axes colors 
and vice versa. 

- Don't invert — Select this option if you do not want to change the colors 
in the image displayed on the screen for printing.

- Use figure's InvertHardcopy setting — Select this option to use the 
InvertHardcopy property set in the Handle Graphics image.

- Make figure background transparent — Select this option to make the 
image background transparent.

Annotation Figure Title
Choose a title option in this section:

- No title: Select this option if you do not want an image title.

- Use block name: Select this option to use the selected block name as the 
plot title. 

- Use variable/file name: Select this option to use the selected variable or 
file name as the plot title.

- Custom: Select this option and enter your own title.

Caption
Enter a short text description for the snapshot figure.
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Insert Anything 
into Report?

Yes. Figure.

Filename rptgen_sl.csl_blk_toworkspace
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4Truth TableCategory Stateflow

Description The Truth Table component reports on the truth tables in Simulink and 
Stateflow models. The component displays both the condition table and the 
action table. This component is context sensitive.

If the Truth Table component has the Simulink Model Loop as its parent, then 
it reports on all truth tables in the current model.

If it has the Simulink System Loop as its parent, then it reports on all truth 
tables in the current system.

If it has the Simulink Block Loop as its parent, then it reports on all truth 
tables in the current block.

If it has the Simulink Signal Loop as its parent, then it reports on all truth 
tables in the current signal.

If it has a Stateflow component, such as Stateflow Filter, Machine Loop, or 
State Loop, as its parent, then it reports on all truth tables in the current object 
type specified by the Stateflow component.

Attributes The following figure shows the Truth Table properties panel:
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Title Title
Choose the title for the truth table:

- No title
- Use Stateflow name
- Custom

Condition Table Specify the display of the condition table:

Show header
Select this option to display the column headers in the table.

Show number
Select this option to display the condition number column in the table.

Show condition
Select this option to display the condition column in the table.
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Show description
Select this option to display the description column in the table.

Wrap if column count
Select this option to specify how many table columns to display before 
creating a table continuation. Note that if the number specified is higher 
than the number of columns that can be displayed on the page, then some 
columns are not displayed in the report.

Action Table Show header
Select this option to display the column headers in the table.

Show number
Select this option to display the condition number column in the table.

Show condition
Select this option to display the condition column in the table.

Show description
Select this option to display the description column in the table.

Note  If Show description is not selected, then no action table is displayed in 
the report.

Insert Anything 
into Report?

Yes. Table.

Filename rptgen_sf.csf_truthtable 
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4Variable TableCategory MATLAB

Description The Variable Table component creates and inserts a table that includes all 
variables in the MATLAB workspace. You can find all the variables in the 
MATLAB workspace by typing whos at the command line.

Attributes The following figure shows the Variable Table properties panel:

Source 
Workspace

Read variables from
Select one of the following options:

- Base workspace — Select this option to read variables from the MATLAB 
workspace.

- MAT-file — Select this option to read variables from a binary file with a 
.mat extension. You can use the %<VariableName> notation. See 
“%<VariableName> Notation” in the Text component reference.

Table Title Table title
Select one of the following options for the table title:
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- Automatic (Variables from MATLAB workspace) — Select this option if 
you want the table title to be a variable name from the MATLAB 
workspace.

- Custom — Select this option and enter the title in this field if you want a 
custom title for the variable table.

If you have a title for a table, it is included in the list of tables if the stylesheet 
you chose in the Report Options attribute page supports it. See “Setting the 
Report Format” on page 2-3 to find stylesheets that have a lst of tables.

Columns in table
Select information to be contained in table columns:

- Variable size (MxN) — Select this option to include the size of the 
variable.

- Variable memory bytes — Select this option to include the number of 
bytes of memory occupied by the variable.

- Variable class — Select this option to include the variable class.

- Variable value — Select this option to include the value of the variable. 
Note that large variable arrays are collapsed to [MxN CLASS]. For example, 
if you have a 300-by-200 double array, it appears in the report as [300x200 
DOUBLE].

Example
This is an example of a variable table that includes size, memory bytes, and 
value information in the table columns.

Name Size Bytes Value 

 aCell 1x2  238  { [ 1 2 3 4 ] Speed (kph) } 

 aNumber  1x1  8  1 

 aString  1x11  22  Speed (kph) 

 aStructure  1x1  302  [struct w/ fields. Inputs, Outputs] 

 aVector  1x4  32  [ 1 2 3 4 ] 
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Insert Anything 
into Report?

Yes. Table.

Filename rptgen.cml_whos
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4While LoopCategory Logical and flow

Description The While Loop component iteratively executes its child components while the 
string specified in the attributes page is true. You can limit the number of 
repetitions to prevent infinite loops. The While Loop component must have at 
least one child component; the purpose of this component is to run its children 
several times. If it does not have any children, this component does not add 
anything to the report.

Attributes The following figure shows the While Loop properties panel:

Logic 
Properties

Continue looping if this expression is true
Enter the string to be evaluated in this field. This string should be a valid 
MATLAB expression that evaluates to 1 or 0 (true or false) in the 
workspace. For example, if a = 1, b = 2, and c = 3 in the MATLAB 
workspace, and you enter the following at the command line,

   d=(a>b/c)

then MATLAB returns the following:
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   d = 1

Because 1 is greater than b/c (2/3), this expression is true, and evaluates 
to 1.

Limit number of loops to
Use this option to prevent infinite loops. Use the left and right arrows to 
increase or decrease the number of loops.

Initialize with this expression
Enter a valid MATLAB expression to initialize the loop.

Insert Anything 
into Report?

Yes, as long as it has a child component.

Filename rptgen_lo.clo_while
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